Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System

OpenArray® Digital PCR Experiments

For use with: DigitalSuite™ Software

Publication Part Number 4471926 Rev. B
Revision Date May 2012
For General Laboratory Use.

For Research Use Only. Not intended for any animal or human therapeutic or diagnostic use.

Information in this document is subject to change without notice.

WARRANTY AND LIABILITY

LIFE TECHNOLOGIES CORPORATION AND/OR ITS AFFILIATE(S) DISCLAIM ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. TO THE EXTENT ALLOWED BY LAW, IN NO EVENT SHALL LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

NOTICE TO PURCHASER: LIMITED USE LABEL LICENSE: Research Use Only

The purchase of this product conveys to the purchaser the limited, non-transferable right to use the purchased amount of the product only to perform internal research for the sole benefit of the purchaser. No right to resell this product or any of its components is conveyed expressly, by implication, or by estoppel.

This product is for internal research purposes only and is not for use in commercial applications of any kind, including, without limitation, quality control and commercial services such as reporting the results of purchaser’s activities for a fee or other form of consideration. For information on obtaining additional rights, please contact outlicensing@lifetech.com or Out Licensing, Life Technologies, 5791 Van Allen Way, Carlsbad, California 92008.

TRADEMARKS

The trademarks mentioned herein are the property of Life Technologies Corporation or their respective owners.

TaqMan and AmpliTaq are registered trademarks of Roche Molecular Systems, Inc. Microsoft and Windows are registered trademarks of Microsoft Corporation.

©2012 Life Technologies Corporation. All rights reserved.
Contents

About This Guide ......................................................... 7
Revision history .......................................................... 7
Purpose .................................................................. 7
Prerequisites ............................................................. 7

CHAPTER 1 Overview of Digital PCR experiments ................. 9
Introduction ................................................................ 9
  Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System .................................................. 9
  QuantStudio™ OpenArray® Plates ........................................ 9
  Digital PCR experiments ............................................. 10
  About digital PCR experiment setup ............................ 11
Digital PCR experiment workflow ......................................... 12
DigitalSuite™ Software .................................................... 13
  Features ................................................................ 13
  DigitalSuite™ Software installation ............................... 14
Analysis workflow .......................................................... 14

CHAPTER 2 Perform a Digital PCR Experiment .................... 15
Prepare the OpenArray® 384-Well Sample Plate .................. 15
  Determine layout of the sample plate ........................... 15
  Prepare the sample plate .......................................... 15
  Storage conditions ................................................. 16
Prepare the QuantStudio™ Digital PCR Plate ....................... 16
  Required materials .................................................. 16
  Procedure .......................................................... 17
Run the QuantStudio™ Digital PCR Plates ......................... 17
  Analyze the data .................................................... 18
CHAPTER 3 Analyze Experiment Results using DigitalSuite™ Software

Overview ................................................................. 20

Section 3.1 General Analysis Workflow ............................................. 21
Create a study ............................................................... 22
  Define study properties .................................................. 23
  Set up plate layout ...................................................... 25
  Set up Samples and Targets ........................................... 28
Analyze a study ............................................................. 31
  Analysis settings ......................................................... 31
View the results ........................................................... 32
  Sample Group tab ..................................................... 32
  Replicate Group tab ................................................... 34
(Optional) Perform QC on results data ........................................... 37
  Heat Map ............................................................... 37
  View the Heat Map ..................................................... 37
  Amplification Plot ..................................................... 40
  View the Amplification Plot ........................................... 40
  Flag Summary ......................................................... 59
Export the analyzed data .............................................................. 60
  Export procedure ....................................................... 60
Supporting features ............................................................. 62
  Preferences ............................................................. 62
  Poisson Calculator .................................................... 62

Section 3.2 Analyzing Singleplex Experiments .................................... 65
About Singleplex experiments .......................................................... 65
Setup a singleplex study .............................................................. 65
  Create a study ......................................................... 65
  Define study properties ................................................ 65
  Setup plate layout ..................................................... 66
  Setup samples and targets ............................................ 67
Analyze the study .............................................................. 68
  View digital PCR results ............................................. 69
Run QC ........................................................................... 71
  Heat Map ............................................................... 71
  Amplification Plot ..................................................... 72
  Flag Summary ......................................................... 74
Export the Study .................................................................... 75
About This Guide

Revision history

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>May 2012</td>
<td>Update in part numbers and references</td>
</tr>
</tbody>
</table>

Purpose

The *Applied Biosystems OpenArray® Digital PCR Experiments User Guide* functions as a tutorial for the scientist analyzing experimental studies performed on the Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System with DigitalSuite™ Software.

Prerequisites

This user guide is intended for users who have been specifically trained by Life Technologies for using the QuantStudio™ 12K Flex Instrument. Customers may start using DigitalSuite™ Software without specifically being trained on that application. The manufacturer is not liable for damage or injury that results from use of this manual by unauthorized or untrained parties.

This guide uses conventions and terminology that assume a working knowledge of the Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

Note: First-time users of the Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System, please see “Documentation and Support” on page 97. The related documentation listed provide resources that detail general instructions applicable to any experiment run on the QuantStudio™ 12K Flex System.
Introduction

Digital PCR provides sensitive, precise, and absolute quantification of nucleic acids without the use of a standard curve. The following components are required to perform digital PCR on the QuantStudio™ 12K Flex System:

- **QuantStudio™ 12K Flex System** – Instrumentation used to load, cycle and detect targets using digital PCR analysis.
- **QuantStudio™ Digital PCR Plates** – Reaction vessels used to contain the digital PCR reactions for thermal cycling and the subsequent imaging by the QuantStudio™ 12K Flex System.
- **TaqMan® OpenArray® Digital PCR Master Mix and Assays** – Fluorescence-based polymerase chain reaction (PCR) reagents used to amplify and detect nucleic acid targets for digital PCR analysis.
- **DigitalSuite™ Software** – Software used to complete statistical analysis of the digital PCR experiments performed on the QuantStudio™ 12K Flex System.

**Applied Biosystems**

**QuantStudio™ 12K Flex Real-Time PCR System**

The Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System consists of the following components:

- **OpenArray® AccuFill™ System** – Loads your samples onto an OpenArray® Digital PCR Plate.
- **QuantStudio™ 12K Flex Instrument** – Performs thermal cycling and imaging of the experiment plates.
- **Computer** – Connects to the QuantStudio™ 12K Flex Instrument. Also has the QuantStudio™ 12K Flex Software installed on it.

**QuantStudio™ OpenArray® Plates**

The QuantStudio™ 12K Flex System requires two plate types:

- **QuantStudio™ OpenArray® 384-Well Sample Plate** (*sample plate*)
- **QuantStudio™ Digital PCR Plate** (*experiment plate*)
Chapter 1  Overview of Digital PCR experiments

Introduction

QuantStudio™ OpenArray® 384-Well Sample Plate

The QuantStudio™ OpenArray® 384-Well Sample Plate is a 384-well reaction plate that is provided in the OpenArray® Real-Time Accessories Kit. You combine the TaqMan® OpenArray® Digital PCR Master Mix, TaqMan® assay, and your DNA sample in the sample plate, then use the OpenArray® AccuFill™ System to transfer the mixture from the sample plate to an OpenArray® plate(s).

IMPORTANT! The well dimensions of the QuantStudio™ OpenArray® 384-Well Sample Plates are specifically suited for use with the OpenArray® AccuFill™ System. Life Technologies does not recommend the use of other microtiter plates with this system.

QuantStudio™ Digital PCR Plate

The QuantStudio™ Digital PCR Plate is a 63-mm × 19-mm mid-density reaction plate. Each plate contains 3072 reaction through-holes, each of which can accommodate a 33-nL reaction volume. The QuantStudio™ Digital PCR Plate is divided into 48 subarrays, where each subarray consists of 64 through-holes. Hydrophilic and hydrophobic coatings allow reagents to be held within the through-holes and isolate the reactions from neighboring through-holes. The large number of reaction through-holes along with the precise control of reaction volume provide a robust platform for digital PCR experimentation.

Digital PCR experiments

What is a digital PCR experiment?

Digital PCR is a statistical technique requiring tens to thousands of reaction replicates to accurately quantify the absolute number of starting copies of a target nucleic acid sequence in a genomic or complementary DNA (cDNA) sample without the use of a standard. Digital PCR analysis requires that at least some reactions within the sample replicate group have zero copies (individual PCR reactions will contain either zero, one, or a few target molecules). Amplification is detected in reactions receiving at least one molecule and classified as positive while no amplification is detectable in reactions not receiving target and is conversely classified as negative. Following PCR, the number of positive and negative reactions is counted and fit to a Poisson distribution to estimate the absolute copies of template molecules present in the sample volume.

For concentrated samples, dilution to the single-molecule limit may be required. For detection of rare targets (mutant sequences, pathogens, transgene content) dilution is generally not required.

Applications of digital PCR include, but are not limited to, quantification of low-level pathogens, detection of rare sequences, gene expression in single cells, and low-fold copy number discrimination of genes/targets.

Digital PCR experiments include the following components:

- **Sample** – The genomic or cDNA sample that contains an unknown number of copies of the target nucleic acid sequence.
- **TaqMan® OpenArray® Digital PCR Master Mix** – An optimized mixture of dNTP, salt, buffer, AmpliTaq® DNA Polymerase, and ROX™ dye passive reference designed for use with TaqMan® Assays and the QuantStudio™ 12K Flex System.
- **TaqMan® Assay** – Includes forward and reverse primers and a specific fluorescent dye-labeled probe for the target nucleic acid sequence.
The probe contains:
- A FAM™ dye (or VIC® dye, in case of a duplex experiments) reporter dye linked to the 5’ end of the probe.
- A minor groove binder (MGB) at the 3’ end of the probe.
  MGB increases the melting temperature (Tm) without increasing probe length (Afonina et al., 1997; Kutyavin et al., 1997); enabling the design of shorter, more specific probes.
- A nonfluorescent quencher (NFQ) at the 3’ end of the probe. Because the quencher does not fluoresce, the QuantStudio™ 12K Flex Instrument can measure reporter dye contributions more accurately.

- **Technical replicates** – Through-hole reactions of each subarray that contain identical sample/assay/reaction mix combinations and volumes. Each subarray of the OpenArray® Digital PCR Plate contains a minimum of 64 technical replicates (resulting from a single well of the 384-well sample plate).

- **(Optional) No template controls (NTCs)** – Samples that contain water or buffer instead of template; also known as negative controls. NTCs should not amplify.

**IMPORTANT!** In DigitalSuite™ Software, NTC is not an assigned task. You can identify a negative control in the Software by naming a Sample "NTC" or something similar. The Software ‘treats’ the NTC-named samples in the same way as the other samples. You need to look out for any amplification in the NTC-named samples as the Software does not produce a flag if amplification occurs in those wells.

---

**About digital PCR experiment setup**

In a digital PCR experiment performed on the QuantStudio™ 12K Flex System, dilutions of each gDNA or cDNA sample are loaded into the wells of an QuantStudio™ 384-Well Sample Plate that contain TaqMan® OpenArray® Digital PCR Master Mix and TaqMan® Assay. If the target concentration is high, samples are diluted down to a limiting quantity prior to assembly of the reaction mix in the QuantStudio™ 384-well Sample Plate, such that a portion of the individual PCR reactions receive no target molecules.
Chapter 1  Overview of Digital PCR experiments

Digital PCR experiment workflow

1. Prepare the reaction mix.
2. Assemble reactions in the QuantStudio™ 384-well sample plate.

Load the OpenArray® Digital PCR Plate

1. Load the OpenArray® AccuFill™ tips, OpenArray® 384-well Sample Plate and QuantStudio™ Digital PCR Plate(s) onto the AccuFill™ System.
2. Run the OpenArray® AccuFill™ System.
3. Seal the plate(s).

Perform Real-Time Imaging

1. Open the Data Collection software.
2. Select Digital PCR .edt (template) file.
3. Place the loaded and sealed QuantStudio™ Digital PCR Plates into the QuantStudio™ 12K Flex Real-Time PCR System, then perform the run.

Review and Export the Run Data

1. Review the results.
2. Save the output .eds file.

Analyze the Data Using DigitalSuite™ Software

1. Create a study by importing the data .eds file.
2. Enter sample, target, and dilution information in Plate Setup.
3. Click Analyze and review results.
4. (Optional) View heat maps and amplification curves to optimize Analysis Settings.
5. Save and export the results for downstream analysis.
DigitalSuite™ Software

DigitalSuite™ Software performs statistical analysis of the digital PCR experiments performed using TaqMan® Assays on the QuantStudio™ 12K Flex System. The DigitalSuite™ Software can be used to detect and measure the absolute number of molecules of specific sequences in a variety of biological samples.

Features

The unique features of the DigitalSuite™ Software include:

- Study-based analysis that can accommodate multiple OpenArrays at a time.
- Accommodates both duplex and singleplex experimental designs.
- Manual and automatic empty well calls.
- Inclusion or omission of individual targets in a well.
- Results generation and re-analysis using an updated dataset.
- Customization of digital PCR settings, flags, and Poisson calculations.
- Export or import of experiment analysis settings.
- Enables viewing of amplification curve groups by target, sample-target and/or sample-target-dilution.
- Provides a histogram plot that helps in distinguishing amplifications.
- Both auto or manual call amplification/non-amplification/undetermined.
- Reporting of results in copies per uL using configurable well volume.
- Individual well-bookmarking enables respective views of the data across the platform.
- Exporting results.
- Print, save to an image file, or export plots.
- Visualization features such as Heat Maps, Scatter Plots and Bar Plots.

Compatible instruments

DigitalSuite™ Software can be used to analyze the results of digital PCR experiments run on the QuantStudio™ 12K Flex System that have been exported as raw amplification curve data (.eds) files.

About the analysis

DigitalSuite™ Software generates copy number data from fluorescence data collected from TaqMan® reactions that have been loaded onto a QuantStudio™ Digital PCR Plate and run on a QuantStudio™ 12K Flex System. Following thermal cycling, the raw amplification curve data from the digital PCR experiment are exported from the data collection software, QuantStudio™ 12K Flex Software. The exported file is then loaded by the DigitalSuite™ Software for analysis.

DigitalSuite™ Software generates calls for all the through-hole reactions. Using the call data, the OpenArray® Digital PCR Software calculates copy number values for all samples present on the plate and, by default, generates 95% confidence intervals according to a Poisson maximum-likelihood algorithm (Fazekas de St. Groth, S, 1982).
DigitalSuite™ Software installation

System requirements

High-level system requirements are as follows:
- 2.4 GHz CPU
- 2 GB RAM

Disk space

Target computer with one hard drive, or no partitions:
- 20 GB of disk space is required.

Target computer with two hard drives, or two partitions:
- 20 GB of disk space is required for the applications drive
- 300 MB of disk space is required for the programs drive

Target computer with three hard drives, or three partitions:
- 20 GB of disk space is required for the applications drive
- 300 MB of disk space is required for the programs drive
- 1 GB of disk space is required for the user files drive

Locate the executable file

Install the software at C:\Program Files\AppliedBiosystems\DigitalSuite Software.

Analysis workflow

The recommended workflow for analyzing results is:
1. Launch DigitalSuite™ Software.
2. Click Create Study to begin a new study.
3. Import the data files into the study.
   Note: The Import dialog box opens automatically on clicking Create Study.
4. Assign sample name and target information for all wells.
5. Analyze and view results.
Perform a Digital PCR Experiment

Prepare the OpenArray® 384-Well Sample Plate

Determine layout of the sample plate

About the sample plate

The OpenArray® 384-Well Sample Plate is divided into eight areas; each sample plate area is 12 wells x 4 wells (48 wells). During each load, the OpenArray® AccuFill™ System transfers sample from one area of a single sample plate to the respective QuantStudio™ Digital PCR Plate, each well of the sample plate loading an individual subarray on the OpenArray® Plate.

Prepare the sample plate

A single QuantStudio™ Digital PCR Plate accepts one load from a sample plate. Be sure that the QuantStudio™ OpenArray® 384-Well Sample Plate, OpenArray® AccuFill™ Loader Tips, and Plate Holder are completely clean and dry.

IMPORTANT! Residual water prevents correct loading of the samples into the QuantStudio™ Digital PCR Plates.
1. Prepare the PCR mix.
   **Note:** For detailed preparation instructions on making the PCR mix, refer to the *Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: OpenArray® Experiments User Guide* (Part no. 4470935).

2. Add sample, master mix, and assay(s) to the sample plate.

3. *(Optional)* Store sealed sample plates.

**Storage conditions**

The following materials require special storage conditions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Storage Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuantStudio™ Digital PCR Plate</td>
<td>Store at –20°C until the expiration date provided on the product label.</td>
</tr>
<tr>
<td>If the OpenArray® plate is...</td>
<td>Store at room temperature for up to 24 hours.</td>
</tr>
<tr>
<td>Frozen, unopened</td>
<td>Store at room temperature for up to 1 hour.</td>
</tr>
<tr>
<td>Thawed, unopened</td>
<td></td>
</tr>
<tr>
<td>Thawed, opened</td>
<td></td>
</tr>
</tbody>
</table>

**Prepare the QuantStudio™ Digital PCR Plate**

**Required materials**

The consumables, materials, and equipment listed are specific to digital experiments.

<table>
<thead>
<tr>
<th>Item†</th>
<th>Source</th>
<th>Part no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuantStudio™ Digital PCR Kit</td>
<td>Life Technologies</td>
<td>4470184 (10 pk)</td>
</tr>
<tr>
<td>available as 10 Pack or 4 Pack</td>
<td></td>
<td>4470185 (4 pk)</td>
</tr>
<tr>
<td>• The 10 Pack includes 10 QuantStudio™ Digital PCR Plates (Part no. 4470197), 2X TaqMan® OpenArray® Digital PCR Master Mix (5 mL, Part no. 4458080), and QuantStudio™ OpenArray® Real-Time PCR Accessories Kit (Part no. 4469576)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• The 4 Pack includes four QuantStudio™ Digital PCR Plates (Part no. 4470196) and 2X TaqMan® OpenArray® Digital PCR Master Mix (1.5 mL, Part no. 4458086)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: The QuantStudio™ OpenArray® Accessories Kit (Part no. 4469576) is included with the 10 Pack but must be purchased separately with the 4 Pack.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DigitalSuite™ Software</td>
<td>Life Technologies</td>
<td>4472102</td>
</tr>
<tr>
<td>DigitalSuite™ Software License Keys (10 pack)</td>
<td>Life Technologies</td>
<td>4472103 (10 pk)</td>
</tr>
</tbody>
</table>
Chapter 2 Perform a Digital PCR Experiment

Run the QuantStudio™ Digital PCR Plates

Procedure

For detailed instructions on the following preparatory and experimental procedures, refer to the Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: OpenArray® Experiments User Guide (Part no. 4470935):

- Use the QuantStudio™ OpenArray® AccuFill™ System to transfer your DNA samples and assays.
- Seal the QuantStudio™ 12K Flex OpenArray® Case.
- Load the prepared QuantStudio™ Digital PCR Plate into the QuantStudio™ 12K Flex Instrument.

Run the QuantStudio™ Digital PCR Plates

Use the QuantStudio™ 12K Flex Software to run the QuantStudio™ Digital PCR Plate. For Digital PCR experiments, the QuantStudio™ Software uses the Plate template file (*.edt) type of data file. Singleplex and duplex experiments require specific *.edt data file. However, the *edt file used for duplex experiments specifies that both FAM® dye and VIC® dye should be collected during the run.

Note: For detailed instructions on running the OpenArray® plates, monitoring experiments, and transferring experiment results, refer to the Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: OpenArray® Experiments User Guide (Part no. 4470935):
Analyze the data

View the data from the .eds file. If the default analysis settings are not suitable for your experiment, you can modify the settings. You can also modify the project files, publish data, and export data for downstream analysis using the DigitalSuite™ Software.

For detailed analysis and export procedures for example singleplex and duplex experiments, refer to Chapter 3, “Analyze Experiment Results using DigitalSuite™ Software” on page 19.
3

Analyze Experiment Results using DigitalSuite™ Software

- Overview ................................................................. 20

Section 3.1 General Analysis Workflow .......................... 21
- Create a study ....................................................... 22
- Analyze a study .................................................... 31
- View the results .................................................... 32
- (Optional) Perform QC on results data ...................... 37
- Export the analyzed data ....................................... 60
- Supporting features .............................................. 62

Section 3.2 Analyzing Singleplex Experiments ............... 65
- About Singleplex experiments ................................ 65
- Setup a singleplex study ...................................... 65
- Analyze the study ............................................... 68
- Run QC ............................................................ 71
- Export the Study ................................................. 75

Section 3.3 Analyzing Duplex Experiments ..................... 79
- About Duplex experiments .................................. 79
- Setup a duplex study .......................................... 79
- Analyze the study ............................................. 82
- Run QC ........................................................... 71
- Export the Study ................................................. 75
Overview

DigitalSuite™ Software is designed for rapid and accurate analysis of QuantStudio™ 12K Flex digital PCR data. In this chapter, you use the example experiment files provided during the DigitalSuite™ Software installation to analyze the digital experiment results. A typical analysis workflow using the DigitalSuite™ Software includes:

1. Launch DigitalSuite™ Software.
2. Create a study.
3. Import one or multiple *.eds file(s).
4. Setup plate layout.
5. Click Analyze.
6. View results.
7. (Optional) Conduct further analysis of the digital PCR data for quality by choosing the Run QC option.
8. Export the analyzed data.

This chapter is divided into three sections. Section 3.1 provides the information and instructions on the overall analysis workflow. Section 3.2 and Section 3.3 include information specific to singleplex and duplex experiments, respectively.
Both singleplex and duplex experiments follow the same general analysis procedure. This section describes the general workflow for digital analysis of experiments. The subsequent individual sections describe specific parameters. This section includes:

- Create a study ................................................................. 22
- Define study properties ............................................... 23
- Set up plate layout ...................................................... 25
- Set up Samples and Targets ........................................ 28
- Analyze a study ............................................................... 31
- View the results ............................................................. 32
  - Sample Group tab .................................................. 32
  - Replicate Group tab ............................................. 34
- (Optional) Perform QC on results data ............................ 37
  - Heat Map ................................................................. 37
  - View the Heat Map .................................................. 37
  - Amplification Plot .................................................. 40
  - View the Amplification Plot ...................................... 40
  - Flag Summary .......................................................... 59
- Export the analyzed data ................................................ 60
  - Export procedure .................................................. 60
- Supporting features .................................................... 62
  - Preferences ............................................................ 62
  - Poisson Calculator .................................................. 62
Create a study

To create a new study, launch DigitalSuite™ Software and on the Home screen, click Create Study.

Alternatively you can create a study from the File menu. Go to File » Create Study.

Note: Launch DigitalSuite™ Software from:

- Start » All Programs » Applied Biosystems » DigitalSuite Software

or

- The Analyze menu on the Home screen of the QuantStudio™ 12K Flex Software

Clicking on Create Study takes you to the Plate Setup screen and automatically opens the Import dialog box.

The default location of the *.eds file is C:\Applied Biosystems\DigitalSuite Software\User Files. To change the default location of the *.eds file, go to Tools » Preferences. For more information on the Preferences dialog box, see “Preferences” on page 62.

A study can include data from one or more OpenArray® plates.

Note: Life Technologies recommends that you do not mix singleplex and duplex experiments in a single study.

Note: Click Save or go to File » Save to save a study.
Once a study is created and saved, the study name is displayed on the Home screen along with the study properties including the study description, the number of OpenArray® plates included present in the study, the date on which the study was created and the date on which the study was last modified.

- Click **Open Study** to open a selected study from the study list on the Home screen. Alternatively, you can double-click on a study name from the study list on the Home screen.

- Click **Transfer Study Out** to move one or more selected studies out to another workstation running DigitalSuite™ Software. Use the Transfer Study Out feature to transfer studies into files that you can back up or pass to another user.

- Click **Transfer Study In** to bring in one or more studies from another location. Only files of type *.las can be transferred in to DigitalSuite™ Software.

- Click **Delete Study** to permanently delete a selected study from the study list on the Home screen.

**Define study properties**

Click **Properties** from the Setup menu located in the Workflow menu on the left to access the Study Properties screen.

1. Enter a unique study name in the Study Name field.
   - Enter a name that is descriptive and easy to remember. You can enter up to 100 characters
• You can only use the alpha-numeric, period (.), hyphen (-), underscore (_), and spaces ( ) characters

**Note:** You cannot use the following characters: % * ? | ; , ! @ # $ ( ) < > / " ' ` ~ [ ] { } = & ^

2. The Study contents box is automatically populated with:
   • The number of experiments in the study
   • The targets in the study
   • The samples in the study

3. The History Summary box is automatically populated with:
   • The date and time stamp when the study was created
   • The date on which the study was last modified

4. *(Optional)* Enter a description for the study in the Description field.

5. *(Optional)* Enter comments in the Comments field. Click Add to add the comments to the comments list. You can add multiple comments at different time intervals.

**IMPORTANT!** Comments added to the Study Properties are time stamped and once added cannot be deleted.

The Study Properties screen for an example study is shown in the following image:
Set up plate layout

Click Plate Setup from the Setup menu to access the Plate Setup screen. The Plate Setup screen is divided into two panes: “Manage Experiments” and “Plate Setup for: (Study Name)”.

Manage Experiments

The Manage Experiments view lists all the *.eds files present in the study. The features under Manage Experiments allow you to:

- **Import**: Import one or multiple OpenArray data files (*.eds files) into a study.
- **Delete**: Delete one or multiple experiments from a study.
- **Generate Plate Template**: Generate plate templates (*.xls files), containing setup information (target name and color, sample name and color, dilution and color) to use for OpenArray® plates in a study. The plate template is generated from the OpenArray data file currently selected.
- **Load Plate Template**: Load setup information (target name and color, sample name and color, dilution and color) from plate templates into one or more selected experiment files.

You can view experiment file name, barcode information, the date on which the experiment was added, and comments in the Manage Experiments view.

**Note**: Comments added to the Plate Setup in the comments field are editable.

Plate Setup for: [Study Name]

The features under the Plate Setup view allow you to assign plate information. The elements of the Plate Setup view are described below.

Assign

Use the Assign feature to assign well contents for a particular sub-array(s) in an experiment.

1. Select one or more sub-arrays in the plate layout.
   
   **Note**: You can select multiple sub-arrays by ‘click and drag’ action over the plate layout, the column headings, or the row headings. You can also use Ctrl or Shift to select multiple sub-arrays.

2. Click **Assign** above the plate layout. Alternatively, right-click on a sub-array or a group of sub-arrays and select Assign Well Content from the drop-down menu. If you are assigning contents to a single sub-array, double-click to open the well editor.

   **Note**: The Assign button remains disabled until you select one or more sub-arrays in the plate layout.

3. In the Assign Well Contents editor:
   
   a. Select TaqMan® Assay 1 or enter a name of your choice for the Target (FAM).
   
   b. (Optional) Select a color for the target from the corresponding drop-down menu.
For duplex experiments, select or enter a name of your choice for the Target (VIC). Optionally, select a color for the target from the corresponding drop-down menu.

For singleplex experiments, Target (VIC) is disabled.

c. Select DNA Sample 1 or enter a name of your choice for the Sample. Optionally, select a color for the sample from the corresponding drop-down menu.

d. Select a dilution from the Dilution drop-down menu or enter a dilution of your choice. Optionally, select a color for the dilution from the corresponding drop-down menu.

**Note:** When you enter a new name for targets, samples, or dilution, the option gets populated in the Samples/Targets screen.

**Note:** When you enter a target or sample name of your own choice, Life Technologies recommends that you use short names, especially when you have a large number of Sample or Replicate Groups. Due to the limited screen size, longer names will truncate on the Results Plot in the Digital PCR screen.

4. Click **Done** after selecting or entering criteria or **Cancel** to exit the Assign Well Contents editor without assigning.

**Note:** You can also copy well contents from one or multiple sub-arrays to another location using the right-click option. In the plate layout, select one or multiple sub-arrays; right-click and select **Copy Wells** from the drop-down options. Select the sub-array at the top-left corner of the destination location and select **Paste Wells** from the right-click drop-down options to paste. Select **Clear** from the right-click drop-down options to clear well information from a sub-array.

**Show**

Use the Show feature to display or hide the well contents in the sub-arrays.

1. Click **Show** above the plate layout.

2. Select the well contents **Sample, Target (FAM), Target (VIC), Dilution** to show or hide from the drop-down menu.

**Color by:**

Use the Color By feature to display the sub-arrays with the color of the selected well contents.

1. Click **Color by:** above the plate layout.
2. Select from **Sample**, **Target (FAM)**, **Target (VIC)**, **Dilution** in the Color by dropdown menu.

Legend

Click the **Legend** above the plate layout to show or hide the plate layout legend.

In addition, the Plate Setup for: view contains the following tools:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Zoom in" /></td>
<td>Zoom in to the plate layout</td>
</tr>
<tr>
<td><img src="image.png" alt="Zoom out" /></td>
<td>Zoom out of the plate layout</td>
</tr>
<tr>
<td><img src="image.png" alt="Fit" /></td>
<td>Fit plate layout to window</td>
</tr>
<tr>
<td><img src="image.png" alt="Print" /></td>
<td>Print the current plate layout</td>
</tr>
<tr>
<td><img src="image.png" alt="Copy" /></td>
<td>Copy the current plate layout</td>
</tr>
<tr>
<td><img src="image.png" alt="Save" /></td>
<td>Save the current plate layout as an image</td>
</tr>
<tr>
<td><img src="image.png" alt="View" /></td>
<td>View the current plate out in full screen</td>
</tr>
<tr>
<td><img src="image.png" alt="Exit" /></td>
<td>Exit full screen view of the plate layout</td>
</tr>
</tbody>
</table>
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

Create a study

The Plate Setup screen for an example study is shown in the following image:

You can prepare the well contents, including samples, targets, and dilutions in the Samples/Targets screen. The samples, targets, and dilutions created in the Samples/Targets screen are populated in the respective drop-down menus of the Well Editor in the Plate Setup screen. You can then select the sample name, target name, and dilutions from the previously-created options. For information on setting up samples, targets, and dilutions in the Samples/Targets screen, see Set up Samples and Targets below.

Set up Samples and Targets

Click Samples/Targets from the Setup menu to access the Samples/Targets screen. The Samples/Targets screen is divided into three sections: Manage Samples, Manage Targets, and Manage Dilutions.

Manage Samples

1. Click Add to add samples to a study. DNA Sample 1 is the default sample names that appears in the Manage Samples section.
2. (Optional) Select a color for the sample from the color drop-down.
3. (Optional) Enter comments in the Comments column.
4. Click Delete to delete selected samples from a study.

Note: You cannot delete the sample names that have been assigned to wells in an experiment included in the study.
Note: The number of wells appearing against a sample name is automatically updated as per the assignment in the Plate Setup screen.

Manage Targets

1. Click to add targets to a study. The default target name that appears in the Manage Targets section is TaqMan® Assay 1.

2. Select the Reporter for the target from the Reporter drop-down menu.
   
   Note: For studies containing singleplex experiments, only FAM™ dye is available in the Reporter drop-down menu. For studies containing duplex experiments, FAM™ dye and VIC® dye are available in the Reporter drop-down menu.

3. (Optional) Select a color for the target from the color drop-down.

4. (Optional) Enter comments in the Comments column.

5. Click to delete selected targets from the study. You cannot delete the target names that have been assigned to wells in an experiment included in the study.

   Note: The number of wells appearing against a sample name is automatically updated as per the assignment in the Plate Setup screen.

Manage Dilutions

1. Click to add dilutions. The default dilutions that appear in the Manage Dilutions section are 1, 0.1, 0.01, 1E-4, 0.
   
The DigitalSuite™ Software computes the next dilution based on the dilution factor. Enter a value from 2 to 100. The default dilution factor is 10.
   
The corresponding row in the Fold column gets populated with the dilution fold for that particular factor.

   Note: For the dilutions, you can enter numeric values or scientific notations like 1E-3 or 0.5E-4.

2. (Optional) Select a color for the dilution from the color drop-down.

3. Click to delete the selected dilutions from the study.

    Note: You cannot delete the dilutions that have been used in an experiment included in the study.
The Samples/Targets screen for an example study is shown in the following image:

**IMPORTANT!** You can rename samples, targets, and dilutions after you have analyzed the study. However, the Results, Run QC, and Export options will get disabled until you re-analyze the study.
Analyze a study

You can analyze a study after you have completed plate set up for the experiment(s) in that study. In the absence of plate set up, the Analyze button appears disabled.

Click **Analyze** to analyze a study. The DigitalSuite™ Software carries out analysis and displays the analysis results in the Digital PCR screen.

**Note:** The Results, Run QC, and Export options from the Workflow menu remain disabled until analysis is done.

If the default analysis settings in the DigitalSuite™ Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your study. To revert to the default settings, click **Reset to Defaults** at the bottom-left of the Analysis Settings dialog box.

Click **Analysis Settings** to access the Analysis Settings dialog box.

Analysis settings

**Digital PCR settings**

Use the Digital PCR Settings tab to change the Confidence Interval, Well Volume, and the Sample Group-Specific Settings.

- **Confidence Interval:** The Confidence Interval is used to calculate the lower and upper confidence values in the Digital PCR screen. For example, for a Confidence Interval value of 95%, the probability of copies/µL falling between the lower and upper confidence values is 95%.
- **Well Volume:** The Well Volume is the actual volume of each through hole in an OpenArray® plate.

**IMPORTANT!** This value is provided for reference purpose and should not be changed unless specified.

- **Sample Group-Specific Settings:** This table contains settings for each sample group in the study including the threshold values for the digital call (positive, negative, and undetermined) as well as the threshold values for empty well detection. See “Amplification Plot” on page 40.

Flag Settings

Use the Flag Settings tab to manually include or exclude a flag and to change the threshold value. The flags present in this table include:

- Low FAM Score
- Low VIC Score

The default threshold value for both the flags is 1.24.
View the results

The Digital PCR screen displays the analysis results for all the experiments in a study. Irrespective of the experiments, the results are grouped by Samples and Replicates. The screen consists of the Sample Group tab and the Replicate Group tab.

The Replicate Group tab displays results for individual dilutions. The Sample Group tab displays the aggregate results for the entire dilution series.

The Digital PCR screen also displays the Confidence Interval for that study in the title bar of the screen. The default value for the Confidence Interval is 95%. This value can be changed in the Analysis Settings dialog box (see “Analysis settings” on page 31).

Sample Group tab

The Sample Group represents all replicates that are assigned with the same sample and target, regardless of the original plates they belong.

The Sample Group tab table includes the following:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Displays the target name</td>
</tr>
<tr>
<td>Sample</td>
<td>Displays the sample name</td>
</tr>
<tr>
<td>Copies/µL</td>
<td>Displays the quantity of sample in copies/µL</td>
</tr>
<tr>
<td>Lower Confidence Level (Lower Conf)</td>
<td>Displays the lower confidence level for the quantity of sample in copies/µL</td>
</tr>
<tr>
<td>Upper Confidence Level (Upper Conf)</td>
<td>Displays the upper confidence level for the quantity of sample in copies/µL</td>
</tr>
<tr>
<td></td>
<td>Displays total number of positive calls</td>
</tr>
</tbody>
</table>

**Note:** Positive calls mean the DigitalSuite™ Software determines a well containing at least one copy of the sample.
On selecting the Sample Group tab, the corresponding Sample Group Results are displayed in the form of a bar graph, with the Sample Group on the X-axis and Copies/µL on the Y-axis, in the lower-half of the Digital PCR screen.

1. To view the plot type, click **Plot**: and select Linear Axis or Logarithmic Axis from the Plot drop-down menu.

2. Click **View » Legend** to show or hide the plot legend.

3. Click **Color by:** and select Target or Sample from the Color by: drop-down menu to assign the bars on the graph with the target or sample color.

4. Move the cursor over the bars in the graph to view the values for Copies/µL, Lower Confidence, and Upper Confidence.

5. To view only specific bars, select the respective rows in the table in the upper half of the screen.
   
   **Note:** To de-select a row, click on that row while holding down the Ctrl key.
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

View the results

Replicate Group tab

The Digital PCR Sample Group screen is shown in the following image:

The Replicate Group represents all replicates that are assigned with the same sample, target, and dilution regardless of the original plates they belong.

The Replicate Group tab table includes the following:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Displays the target name</td>
</tr>
<tr>
<td>Sample</td>
<td>Displays the sample name</td>
</tr>
<tr>
<td>Dilution</td>
<td>Displays the dilution for that group</td>
</tr>
<tr>
<td>Copies/µL</td>
<td>Displays the number of replicate group copies present per µL</td>
</tr>
<tr>
<td>Lower Confidence Level</td>
<td>Displays the lower confidence level for the number of copies present per µL</td>
</tr>
<tr>
<td>(Lower Conf)</td>
<td></td>
</tr>
<tr>
<td>Upper Confidence Level</td>
<td>Displays the upper confidence level for the number of copies present per µL</td>
</tr>
<tr>
<td>(Upper Conf)</td>
<td></td>
</tr>
<tr>
<td>![positive calls]</td>
<td>Displays total number of positive calls</td>
</tr>
</tbody>
</table>

Note: Positive calls mean the DigitalSuite™ Software determines a well containing at least one copy of the sample.
View the results

On selecting the Replicate Group tab, the corresponding Replicate Group Results are displayed in the form of a bar graph, with the Replicate Group on the X-axis and Copies/µL on the Y-axis, in the lower-half of the Digital PCR screen.

1. To view the plot type, click **Plot:** and select Linear Axis or Logarithmic Axis from the Plot drop-down menu.

2. Click **View** to show or hide the plot legend.

3. Click **Color by:** and select Target, Sample, or Dilution from the Color by: drop-down menu to assign the bar graph with the target, sample, or dilution color.

4. Move the cursor over the bars in the graph to view the values for Copies/µL, Lower Confidence, and Upper Confidence.

5. To view only specific bars, select the respective rows in the table in the upper half of the screen.
   
   **Note:** To de-select a row, click on that row while holding down the Ctrl key.

---

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Displays total number of negative calls</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Negative calls mean the DigitalSuite™ Software determines that a well does not contain any copy of the sample.</td>
</tr>
<tr>
<td>?</td>
<td>Displays total number of undetermined calls.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Undetermined calls are those that occur between the positive and negative range as well as beyond the positive range on the histogram plot.</td>
</tr>
<tr>
<td># of Positive + Negative</td>
<td>Displays the combined number of wells having the positive and negative calls</td>
</tr>
<tr>
<td>(# of Pos+Neg)</td>
<td></td>
</tr>
<tr>
<td># of Omitted</td>
<td>Displays the number of wells omitted from the study</td>
</tr>
<tr>
<td># of Empty</td>
<td>Displays the number of empty wells</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Empty wells are those that are flagged with Low ROX, Low FAM, or Low VIC.</td>
</tr>
</tbody>
</table>

Displays total number of negative calls

**Note:** Negative calls mean the DigitalSuite™ Software determines that a well does not contain any copy of the sample.

Displays total number of undetermined calls.

**Note:** Undetermined calls are those that occur between the positive and negative range as well as beyond the positive range on the histogram plot.

Displays the combined number of wells having the positive and negative calls

Displays the number of wells omitted from the study

Displays the number of empty wells

**Note:** Empty wells are those that are flagged with Low ROX, Low FAM, or Low VIC.
The Digital PCR Replicate Group screen is shown in the following image:

In addition to the tools mentioned above:

- The Sample Group Results and Replicate Group Results plot view includes , , , and to zoom in, zoom out, to fit data in window, and to view data in full screen respectively.
- Click , , and to print, copy, and save the plot as an image respectively.
- Click to access and edit the Plot Properties such as the font and color of the plot text, and the labels on the X axis and Y Axis. Edit the settings under the General, X Axis, and Y Axis tab.
  - Click the General tab to edit the plot title text, font, or color. You can also select whether to show the plot title.
  - Click the X Axis tab to edit the x axis label text, font, or color; select the tick marks and tick mark labels to display; and select the range to display.
  - Click the Y Axis tab to edit the y axis label text, font, or color; select the tick marks and tick mark labels to display; and select the range to display.
  - Click OK.
(Optional) Perform QC on results data

You can perform a quality check on the digital PCR data and conduct further analysis, if necessary. Use Heat Maps, Amplification Plots, and Flag Summary from the Run QC Workflow.

Heat Map

The heat map provides you with an overview of all the wells in the same plate. By default, the Heat Map is colored by ‘Call’. The green wells represent positive calls while the black wells represent negative calls. The grey wells represent undetermined calls. The heat map allows you to check for:

• The density of the positive and negative calls for quick visual review with respect to the dilution series.
• Amplification in wells labelled as NTC. NTC wells are supposed to be negative.
• Sample filling problems or suspected contamination in the plate through abnormal density patterns.
• Flagged wells. Conduct further investigation of flagged wells in the Amplification Plot screen.

Note: Flagged wells are marked with a △ triangle in the affected well.

View the Heat Map

Go to Run QC → Heat Map to access the Heat Map screen.

The Heat Map screen includes the Experiments view in the upper half and the Heat Map for view in the lower half of the screen.

The upper half of the Heat Map screen lists the experiments included in the study while the lower half displays the corresponding heat map for the experiment selected in the Experiments (upper half) view.

Experiments

The Experiments view lists all the experiments included in a study. The Experiments view table includes:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark</td>
<td>Indicates whether there are bookmarked wells in the experiment.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
</tr>
<tr>
<td></td>
<td>• To bookmark a well, select one or more wells in the plate layout right-click and select Add Bookmark from the drop-down menu</td>
</tr>
<tr>
<td></td>
<td>• Select Select all bookmarks to select all the bookmarked wells in the current plate</td>
</tr>
<tr>
<td></td>
<td>• Select Clear selected bookmarks to clear bookmarks from the selected wells</td>
</tr>
<tr>
<td></td>
<td>• Select Clear all bookmarks to clear all bookmarked wells off the bookmark</td>
</tr>
<tr>
<td>File Name</td>
<td>Displays the file name of an experiment in the study.</td>
</tr>
</tbody>
</table>

IMPORTANT! Bookmarks are lost once you close a study.
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode</td>
<td>Displays the barcode of the OpenArray® plate on which the dPCR experiment has been run.</td>
</tr>
<tr>
<td>FAM</td>
<td>Displays the number of wells with low FAM™ dye signal.</td>
</tr>
<tr>
<td>VIC</td>
<td>Displays the number of wells with low VIC® dye signal.</td>
</tr>
<tr>
<td>VIC (duplex)</td>
<td>Displays the number of wells with low VIC® dye signal (only for duplex experiments). For singleplex experiments, this column displays N/A.</td>
</tr>
<tr>
<td>F (FAM)</td>
<td>Displays the number of wells with a FAM™ dye score that is lower than the threshold value specified in the Analysis settings.</td>
</tr>
<tr>
<td>V (VIC)</td>
<td>Displays the number of wells with a VIC® dye score that is lower than the threshold value specified in the Analysis settings [only for duplex experiments]. For singleplex experiments, this column displays N/A.</td>
</tr>
</tbody>
</table>

**Heat Map for (experiment name):**

The Heat Map For: view displays the heat map for the experiment file selected in the Experiments view. The tools on this view include:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAM</td>
<td>Displays the FAM™ dye signal in wells.</td>
</tr>
<tr>
<td>VIC</td>
<td>Displays the VIC® dye signal in wells (only for duplex experiments). This button appears disabled for singleplex experiments.</td>
</tr>
<tr>
<td>Show</td>
<td>Drop-down menu that enables you the option to show flags in wells.</td>
</tr>
<tr>
<td>Color by: Call</td>
<td>Drop-down menu that enables you options to color the cells using different data elements. Select Call, C&lt;sub&gt;RT&lt;/sub&gt;, Sample, Target, or Dilution.</td>
</tr>
<tr>
<td>Omission</td>
<td>Drop-down menu that enables you to omit flagged or contaminated wells. You can copy the result from A1 sub-array to other sub-arrays as well as apply to other plates. Select Copy A1 to all sub-arrays (all dyes) or Apply to all plates (all dyes)</td>
</tr>
<tr>
<td>Legend</td>
<td>Toggle button. Shows or hides the plate legend below the heat map.</td>
</tr>
</tbody>
</table>

To omit a particular well(s), select the well(s) in the plate layout, right-click on the selection, and select **Omit** from the drop-down menu.

To include an omitted well(s), select the omitted well(s) in the plate layout, right-click on the well(s), and select **Include** from the drop-down menu.
In addition, the Heat Map for: view contains the following tools:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Zoom in to the heat map</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Zoom out of the heat map</td>
</tr>
<tr>
<td><img src="image" alt="Fit" /></td>
<td>Fit heat map to window</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print the current heat map</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy the current heat map</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save the current heat map as an image</td>
</tr>
<tr>
<td><img src="image" alt="FullScreen" /></td>
<td>View the current heat map in full screen</td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td>Exit full screen view of the heat map</td>
</tr>
</tbody>
</table>

The Heat Map for an example study is shown in the following image:
Note: Bookmarks are applied at the Replicate level. For duplex experiments, bookmarking wells for one reporter dye does not bookmark the same well with the second reporter dye. To bookmark the same set of wells with the second reporter dye.

1. Go to Run QC » Heat Map.

2. In the Heat Map, right-click and select Select all bookmarks from the menu to select all bookmarked wells.

3. Click the other reporter dye button in the tool bar to switch to the Heat Map for that reporter dye.

**IMPORTANT!** Do not left-click anywhere in the heat map at this point as it will clear the well selection.

4. With the wells still selected, right-click on the wells, and select Add bookmark from the menu to add the bookmark for the same set of wells for the second reporter dye.

You can now view the bookmarked wells for the second reporter dye in the well table in the Amplification Plot screen.

**Amplification Plot**

The Amplification Plot of a study displays the amplification curve for wells grouped by Target, Target and Sample (Sample Group), or Target, Sample, and Dilution (Replicate Group). Two types of amplification plots are available:

- **ΔR vs. Cycle** – ΔR is the baseline adjusted fluorescence signal generated by the reporter at each cycle during the PCR amplification. This plot displays ΔR as a function of cycle number. You can use this plot to identify and examine irregular amplification and to view C_{RT} values for the run.

- **R vs. Cycle** – R is the absolute fluorescence signal from the reporter dye. This plot displays R as a function of cycle number. Use this plot to identify and examine irregular amplification.

Each plot can be viewed as a linear or log10 graph type.

**Note:** For the Sample Group view, there is an additional plot, ROX vs. Reporter Dye available.

**Purpose**

The purpose of viewing the amplification plot in a study is to:

- Review analysis results, including C_{RT} value; Amp Score; Positive, Negative or Undetermined calls, and empty wells detection
- Review the Histogram of the C_{RT} values for the selected Sample Group
- Adjust the thresholds for making positive, negative, or undetermined calls for the selected Sample Group
- Evaluate the quality of the amplification curve, especially those wells containing flags and if necessary, omit those
- Manually change calls or empty wells detection results

**View the Amplification Plot**

The Amplification Plot screen includes three views:

- Targets
• Sample Group
• Replicate Group

Target view

The Target table lists the targets in the study. The Targets table includes the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark</td>
<td>Indicates whether a target is present in a bookmarked well. To bookmark a well: • On the Heat Map screen, select one or more wells in the plate layout right-click and select Add Bookmark from the drop-down menu or • On the Amplification Plot screen, in the Well Table, select Add Bookmark from the Bookmark drop-down menu or from the right-click drop-down menu</td>
</tr>
<tr>
<td>Target</td>
<td>Displays the target name.</td>
</tr>
<tr>
<td>ROX</td>
<td>Displays the number of wells with low ROX signal.</td>
</tr>
<tr>
<td>FAM™</td>
<td>Displays the number of wells with low FAM™ dye signal.</td>
</tr>
<tr>
<td>VIC®</td>
<td>Displays the number of wells with low VIC® dye signal (only for duplex experiments). For singleplex experiments, this column displays N/A.</td>
</tr>
<tr>
<td></td>
<td>Displays the number of wells with a FAM™ dye score that is lower than the threshold value specified in the Analysis settings.</td>
</tr>
<tr>
<td></td>
<td>Displays the number of wells with a VIC® dye score that is lower than the threshold value specified in the Analysis settings (only for duplex experiments). For singleplex experiments, this column displays N/A.</td>
</tr>
</tbody>
</table>

The lower half of the Targets view displays the plot view and well table. Use the ↓, ↑, ←, and → buttons to extend the views horizontally or vertically.

You can select wells in the plot view or the well table. In the plot view, select wells by clicking in the plot and dragging a rubber-band box. In the well table, select wells by selecting the respective rows. Wells selected in the plot view will appear selected in the well table and vice-versa. In the plot view, selected wells will appear colored, while unselected wells will be hidden. To view unselected wells, go to View → Show Unselected. The unselected wells will appear in grey color in the plot view. If no wells are selected, the plot view displays all the wells in color.

The Plot View includes the following tools:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Drop-down menu that enables you to select from ΔR vs. Cycle (Linear), ΔR vs. Cycle (Log), R vs. Cycle (Linear), and R vs. Cycle (Log) plot types</td>
</tr>
</tbody>
</table>
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

(Optional) Perform QC on results data

In addition to the tools mentioned above:

- The Targets plot view includes buttons to zoom in, zoom out, to fit data in window, and to view data in full screen respectively. 
  
  **Note:** To zoom into a particular area of the amplification plot, click at the center of the area of interest then click.

- Click to print, copy, and save the plot as an image respectively.

- Click to access and edit the Plot Properties.

The Plot view for the Targets tab of an example study is shown in the following image:
The Well Table includes the following tools:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![View](#) | Drop-down menu that allows you to show or hide columns in a table. Select or Deselect the following:  
- Call  
- Call Type  
- Bookmark  
- Omit  
- Empty Well Flag  
- Empty Type  
- $C_{RT}$  
- Amp Score  
- Experiment  
- Flag indicator  
- Flags  
  - Low ROX  
  - Low FAM  
  - Low VIC  
  - Low FAM Score  
  - Low VIC Score  
  Note: Wells with undetermined calls are not flagged for Low FAM Score or Low VIC Score even if their Amp Score value is less than threshold. |
| ![Group by](#) | Drop-down menu that enables you to group the targets by experiments or by none. Select from:  
- None  
- Experiment  
- Expand All  
- Collapse All  
  Note: The Expand All and Collapse All options are enabled only when Experiment is selected. |
| ![Bookmark](#) | Drop-down menu that enables you to add, select, and clear bookmarked wells. Select from Add Bookmark, Select all bookmarks, Clear selected bookmark, Clear all bookmarks. |
| ![Change Call](#) | Drop-down menu that enables you to manually change the call for a well(s). Select Positive, Negative or Undetermined.  
You can also use this drop-down menu to Clear Manual Call, Mark as Empty Well, Mark as Non-Empty Well, Auto Empty Detection.  
Note: When you manually change the call for a well(s), the call will remain unchanged even after you re-analyze the study. |
The following table provides definitions for the column headings that appear in the tables in the Targets tab:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Displays the Well location</td>
</tr>
</tbody>
</table>
| Call           | Displays the call in the well (Positive, Negative, or Undetermined)  
**Note:** Positive calls are indicated by ✅, Negative calls are indicated by ❌, and Undetermined calls are indicated by 🎉 |
| Call Type      | Whether the call is Auto or has been changed manually |
| Bookmark       | Indicates if the well is bookmarked |
| Omit           | Includes a check box to omit a well |
| Empty Type     | Whether the well has been labelled empty automatically or manually |
| C_{RT}         | C_{RT} value for a well |
| Amp Score      | Amp Score value for a well |
| Experiment     | Name of the experiment to which the target belongs |
| Flag Indicator | Flag Indicator. Displays the number of flags in a well  
![Flag Indicator](image) |
| ROX            | The icon displayed if the well is flagged with Low ROX  
![Low ROX Flag](image) |
| FAM            | The icon displayed if the well is flagged with Low FAM  
![Low FAM Flag](image) |
| VIC            | The icon displayed if the well is flagged with Low VIC (only for duplex experiments). For singleplex experiments, this column displays N/A  
![Low VIC Flag](image) |
| FAM Score      | The icon displayed if the well is flagged with Low FAM Score  
![Low FAM Score Flag](image) |
| VIC Score      | The icon displayed if the well is flagged with Low VIC Score  
![Low VIC Score Flag](image) |

**Note:** You can sort the table columns by clicking once on the column header. You can change the sorting order with a second click. A third click will clear the sorting order. You can sort the table columns at multiple levels. For example, click the Call column to sort the columns by Call, then hold down the Ctrl key and click the C_{RT} column to sort by C_{RT} the wells with the same call.
The Well Table view for the Targets tab of an example study is shown in the following image:

Sample Group view

The Sample Group table lists the sample groups (replicates assigned with the same sample and target) in the study. The Sample Group table includes the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark</td>
<td>Indicates whether a target is present in a bookmarked well.</td>
</tr>
<tr>
<td></td>
<td>To bookmark a well:</td>
</tr>
<tr>
<td></td>
<td>• On the Heat Map screen, select one or more wells in the plate layout right-click and select <strong>Add Bookmark</strong> from the drop-down menu or</td>
</tr>
<tr>
<td></td>
<td>• On the Amplification Plot screen, in the Well Table, select <strong>Add Bookmark</strong> from the Bookmark drop-down menu or from the right-click drop-down menu</td>
</tr>
<tr>
<td>Target</td>
<td>Displays the target name.</td>
</tr>
<tr>
<td>Sample</td>
<td>Displays the sample name.</td>
</tr>
<tr>
<td>Copies/µL</td>
<td>Displays the number of copies of the sample group per µL.</td>
</tr>
<tr>
<td><img src="Image" alt="Positive Call" /></td>
<td>Displays total number of positive calls.</td>
</tr>
<tr>
<td><img src="Image" alt="Negative Call" /></td>
<td>Displays total number of negative calls.</td>
</tr>
</tbody>
</table>

**Note:** Positive calls mean the DigitalSuite™ Software determines a well containing at least one copy of the sample.

**Note:** Negative calls mean the DigitalSuite™ Software determines that a well does not contain any copy of the sample.
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

(Optional) Perform QC on results data

### The lower half of the Sample Group view displays the plot view and well table. Use the , , , and  buttons to extend the views horizontally or vertically.

You can select wells in the plot view or the well table. In the plot view, select wells by clicking in the plot and dragging a rubber-band box. In the well table, select wells by selecting the respective rows. Wells selected in the plot view will appear selected in the well table and vice-versa. In the plot view, selected wells will appear colored, while unselected wells will be hidden. To view unselected wells, go to View » Show Unselected. The unselected wells will appear in grey color in the plot view. If no wells are selected, the plot view displays all the wells in color.

The Plot View includes the following tools:

<table>
<thead>
<tr>
<th>Tool Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool</td>
</tr>
<tr>
<td><img src="Plot" alt="" /> Yellow</td>
</tr>
</tbody>
</table>
Section 3.1  General Analysis Workflow

(Optional) Perform QC on results data

In addition to the tools mentioned above:

- The Targets plot view includes , , , and  to zoom in, zoom out, to fit data in window, and to view data in full screen respectively.
  **Note:** To zoom into a particular area of the amplification plot, click at the center of the area of interest then click .

- Click , , and  to print, copy, and save the plot as an image respectively.

- Click  to access and edit the Plot Properties.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![View](image) | Drop-down menu that enables you to show and hide the following:
  - C<sub>RT</sub> Range  
    **Note:** C<sub>RT</sub> Range includes two ranges, the positive range and negative range. The positive range is colored in green in the Histogram plot. If the well C<sub>RT</sub> falls within this range, the well will be called Positive. The negative range is colored red in the Histogram plot. If the well C<sub>RT</sub> falls within this range, the well will be called Negative.
  - Histogram  
    **Note:** The Histogram shows the distribution of the C<sub>RT</sub> values for a given Sample Group. Each bar in the Histogram represents the number of wells whose C<sub>RT</sub> values falls between a small range of 0.1 such as 30.1-30.2.
  - No Amplification Bar  
    **Note:** The No Amplification Bar counts the number of wells for undetermined C<sub>RT</sub>. This option is enabled only when you select the Histogram option.
  - Legend  
  - Show Unselected  
  - C<sub>RT</sub>  
  - Show Omitted |
| ![Color by: Call](image) | Drop-down menu that enables you options to color the plot using different data elements. Select Bookmarks, Targets, Wells, or Call. |
The Plot view for the Sample View tab of an example study is shown in the following image:
Adjusting the $C_{RT}$ range

You can hold the cursor over the bars in the Histogram plot to view the positive and negative $C_{RT}$ range (the green and red shaded regions in the Amplification Plot or Histogram Plot).

The initial $C_{RT}$ range is automatically detected based on the Histogram. However, you can manually change the $C_{RT}$ range by dragging the edge of the shaded region to manually adjust the $C_{RT}$ range. DigitalSuite™ Software does not allow overlapping of the positive and negative $C_{RT}$ range. When you manually change the $C_{RT}$ range, the value gets updated in the Min Pos $C_{RT}$, Max Pos $C_{RT}$ and Min Neg $C_{RT}$ columns in the Analysis Settings dialog box.

Alternatively, the threshold values are also available and can be changed directly in the Analysis settings dialog box (see “Analysis settings” on page 31).

To revert to automatic $C_{RT}$ range:

1. Click Analysis Settings to access the Analysis Settings dialog box.

2. In Sample Group-Specific Settings find the corresponding Sample Group.
3. Select the check box for the Auto column appearing to the right of the Sample column.

Adjusting the empty well threshold

You can adjust the empty well threshold in the ROX vs. Reporter Dye plot from the Plot drop-down menu. The ROX vs. Reporter Dye Plot plots the ROX dye signal on the X-axis against the Reporter Dye (FAM™ dye or VIC® dye) signal on the Y-axis. The reporter dye value for a given well is taken from the median value of the first five cycles for that well.

The empty wells are seen as ‘×’ in the ROX vs. Reporter Dye plot, while non-empty wells as seen as colored boxes. By default, the wells are colored by their Calls.

The grey shaded area on this plot indicates the region containing non-empty wells. The left edge of the shaded area is the threshold for Low ROX and the bottom edge of the shaded area is the threshold for the Reporter Dye.

The initial grey area on the ROX vs. Reporter Dye plot is automatically detected based on the distribution of all the wells on the plot for the given Sample Group. The wells that have ROX or reporter signals significantly lower than other wells, will be flagged as Low ROX, Low FAM or Low VIC accordingly; and subsequently flagged as empty wells. However, you can adjust the area by manually dragging the lower-left corner of the shaded area.
The Threshold values are also available and can be changed in the Analysis settings dialog box (see “Analysis settings” on page 31).

To revert to the initial Low ROX and Low FAM/Low VIC range:

1. Click Analysis Settings to access the Analysis Settings dialog box.
2. In Sample Group-Specific Settings find the corresponding Sample Group.
3. Select the check box for the Auto column appearing to the left of the Low ROX column.

**IMPORTANT!** For duplex experiments, there is a possibility to see a ‘×’ within the grey shaded area. The ROX vs. Reporter Dye plot displays only one reporter, either FAM dye or VIC dye. In duplex experiments, the same well appears in two sample groups, one for each reporter dye. Therefore, there is a possibility that the well that appears within the grey shaded area for one reporter dye can appear outside the grey shaded area for the other reporter dye. This well will appear with the ‘×’ for both reporter dyes.
The Well Table includes the following tools:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![View](image) | Drop-down menu that allows you to show or hide columns in a table. Select or Deselect the following:  
  - Call  
  - Call Type  
  - Bookmark  
  - Omit  
  - Empty Well Flag  
  - Empty Type  
  - CRT  
  - Amp Score  
  - Experiment  
  - Flag indicator  
  - Flags  
    - Low ROX  
    - Low FAM  
    - Low VIC  
    - Low FAM Score  
    - Low VIC Score  
  Note: Wells with undetermined calls are not flagged for Low FAM Score or Low VIC Score even if their Amp Score value is less than threshold. |
| ![Group by](image) | Drop-down menu that enables you to group the targets by experiments or by none. Select from:  
  - None  
  - Experiment  
  - Expand All  
  - Collapse All  
  Note: The Expand All and Collapse All options are enabled only when Experiment is selected |
| ![Bookmark](image) | Drop-down menu that enables you add, select, and clear bookmarked wells. Select from Add Bookmark, Select all bookmarks, Clear selected bookmark, Clear all bookmarks |
| ![Change Call](image) | Drop-down menu that enables you to manually change the call for a well(s). Select Positive, Negative or Undetermined.  
  You can also use this drop-down menu to Clear Manual Call, Mark as Empty Well, Mark as Non-Empty Well, Auto Empty Detection.  
  Note: When you manually change the call for a well(s), the call will remain unchanged even after you re-analyze the study. |
The following table provides definitions for the column headings that appear in the well tables in the Sample View tab:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Displays the Well location</td>
</tr>
</tbody>
</table>
| Call           | Displays the call in the well (Positive, Negative, or Undetermined)  
**Note:** Positive calls are indicated by , Negative calls are indicated by , and Undetermined calls are indicated by ? |
| Call Type      | Whether the call is Auto or has been changed manually |
| Bookmark       | Indicates if the well is bookmarked |
| Omit           | Includes a check box to omit a well |
| Empty Type     | Whether the well has been labelled empty automatically or manually |
| \(C_{RT}\)     | \(C_{RT}\) value for a well |
| Amp Score      | Amp Score value for a well |
| Experiment     | Name of the experiment to which the target belongs |
| Flag Indicator | Flag Indicator: Displays the number of flags in a well |
| Low ROX        | The icon displayed if the well is flagged with Low ROX |
| Low FAM        | The icon displayed if the well is flagged with Low FAM |
| Low VIC        | The icon displayed if the well is flagged with Low VIC (only for duplex experiments). For singleplex experiments, this column displays N/A |
| Low FAM Score  | The icon displayed if the well is flagged with Low FAM Score |
| Low VIC Score  | The icon displayed if the well is flagged with Low VIC Score |

**Note:** You can sort the table columns by clicking once on the column header. You can change the sorting order with a second click. A third click will clear the sorting order. You can sort the table columns at multiple levels. For example, click the Call column to sort the columns by Call, then hold down the Ctrl key and click the \(C_{RT}\) column to sort by \(C_{RT}\) the wells with the same call.
The Well Table view for the Sample Group tab of an example study is shown in the following image:

Replicate Group view

The Replicate Group table lists the targets in the study. The Targets table includes the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark</td>
<td>Indicates whether a target is present in a bookmarked well</td>
</tr>
<tr>
<td></td>
<td>To bookmark a well:</td>
</tr>
<tr>
<td></td>
<td>• On the Heat Map screen, select one or more wells in the plate layout right-click and select <strong>Add Bookmark</strong> from the drop-down menu</td>
</tr>
<tr>
<td></td>
<td>• On the Amplification Plot screen, in the Well Table, select <strong>Add Bookmark</strong> from the Bookmark drop-down menu or from the right-click drop-down menu</td>
</tr>
<tr>
<td>Target</td>
<td>Displays the target name.</td>
</tr>
<tr>
<td>Sample</td>
<td>Displays the sample name.</td>
</tr>
<tr>
<td>Dilution</td>
<td>Displays the dilution for the group.</td>
</tr>
<tr>
<td>Copies/µL</td>
<td>Displays the number of copies of the sample group per µL.</td>
</tr>
<tr>
<td></td>
<td>Displays total number of positive calls.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Positive calls mean the DigitalSuite™ Software determines a well containing at least one copy of the sample.</td>
</tr>
<tr>
<td></td>
<td>Displays total number of negative calls.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Negative calls mean the DigitalSuite™ Software determines that a well does not contain any copy of the sample.</td>
</tr>
</tbody>
</table>
The lower half of the Targets view displays the plot view and well table. Use the , , , , and buttons to extend the views horizontally or vertically.

You can select wells in the plot view or the well table. In the plot view, select wells by clicking in the plot and dragging a rubber-band box. In the well table, select wells by selecting the respective rows. Wells selected in the plot view will appear selected in the well table and vice-versa. In the plot view, selected wells will appear colored, while unselected wells will be hidden. To view unselected wells, go to View » Show Unselected. The unselected wells will appear in grey color in the plot view. If no wells are selected, the plot view displays all the wells in color.

The Plot View includes the following tools:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="plot_icon" alt="Plot" /></td>
<td>Drop-down menu that allows you to select ΔR vs. Cycle (Linear), ΔR vs. Cycle (Log), R vs. Cycle (Linear), and R vs. Cycle (Log) plot types.</td>
</tr>
</tbody>
</table>
| ![View](view_icon) | Drop-down menu that enables you to show and hide the following:  
• Legend  
• Show Unselected  
• C<sub>RT</sub>  
• Show Omitted |
In addition to the tools mentioned above:

- The Targets plot view includes ∇, ▲, and ▼ to zoom in, zoom out, to fit data in window, and to view data in full screen respectively.

  **Note:** To zoom into a particular area of the amplification plot, click at the center of the area of interest then click ∇.

- Click ▼, ▲, and ▼ to print, copy, and save the plot as an image respectively.

- Click ◀ to access and edit the Plot Properties.

The Plot view for the Replicate Group tab of an example study is shown in the following image:

![ΔR vs Cycle (Linear)](image-url)
The Well Table includes the following tools:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Drop-down menu that allows you to show or hide columns in a table. Select or Deselect the following:</td>
</tr>
<tr>
<td></td>
<td>• Call</td>
</tr>
<tr>
<td></td>
<td>• Call Type</td>
</tr>
<tr>
<td></td>
<td>• Bookmark</td>
</tr>
<tr>
<td></td>
<td>• Omit</td>
</tr>
<tr>
<td></td>
<td>• Empty Well Flag</td>
</tr>
<tr>
<td></td>
<td>• Empty Type</td>
</tr>
<tr>
<td></td>
<td>• C&lt;sub&gt;RT&lt;/sub&gt;</td>
</tr>
<tr>
<td></td>
<td>• Amp Score</td>
</tr>
<tr>
<td></td>
<td>• Experiment</td>
</tr>
<tr>
<td></td>
<td>• Flag indicator</td>
</tr>
<tr>
<td></td>
<td>• Flags</td>
</tr>
<tr>
<td></td>
<td>• Low ROX</td>
</tr>
<tr>
<td></td>
<td>• Low FAM</td>
</tr>
<tr>
<td></td>
<td>• Low VIC</td>
</tr>
<tr>
<td></td>
<td>• Low FAM Score</td>
</tr>
<tr>
<td></td>
<td>• Low VIC Score</td>
</tr>
<tr>
<td></td>
<td>Note: Wells with undetermined calls are not flagged for Low FAM Score or Low VIC Score even if their Amp Score value is less than threshold.</td>
</tr>
<tr>
<td>Group by</td>
<td>Drop-down menu that enables you to group the targets by experiments or by none. Select from:</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Experiment</td>
</tr>
<tr>
<td></td>
<td>• Expand All</td>
</tr>
<tr>
<td></td>
<td>• Collapse All</td>
</tr>
<tr>
<td></td>
<td>Note: The Expand All and Collapse All options are enabled only when Experiment is selected.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Drop-down menu that enables you add, select, and clear bookmarked wells. Select from Add Bookmark, Select all bookmarks, Clear selected bookmark, Clear all bookmarks.</td>
</tr>
<tr>
<td>Change Call</td>
<td>Drop-down menu that enables you to manually change the call for a well(s). Select Positive, Negative or Undetermined.</td>
</tr>
<tr>
<td></td>
<td>You can also use this drop-down menu to Clear Manual Call, Mark as Empty Well, Mark as Non-Empty Well, Auto Empty Detection.</td>
</tr>
<tr>
<td></td>
<td>Note: When you manually change the call for a well(s), the call will remain unchanged even after you re-analyze the study.</td>
</tr>
</tbody>
</table>
The following table provides definitions for the column headings that appear in the tables in the Replicate Group tab:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Displays the Well location</td>
</tr>
</tbody>
</table>
| Call           | Displays the call in the well (Positive, Negative, or Undetermined)  
**Note:** Positive calls are indicated by +, Negative calls are indicated by -, and Undetermined calls are indicated by ? |
| Call Type      | Whether the call is Auto or has been changed manually |
| Bookmark       | Indicates if the well is bookmarked |
| Omit           | Includes a check box to omit a well |
| Empty Type     | Whether the well has been labelled empty automatically or manually |
| \( C_{RT} \)   | \( C_{RT} \) value for a well |
| Amp Score      | Amp Score value for a well |
| Experiment     | Name of the experiment to which the target belongs |
| ![Warning Icon](image) | Flag Indicator. Displays the number of flags in a well |
| ![ROX Icon](image) | The icon displayed if the well is flagged with Low ROX |
| ![FAM Icon](image) | The icon displayed if the well is flagged with Low FAM |
| ![VIC Icon](image) | The icon displayed if the well is flagged with Low VIC (only for duplex experiments). For singleplex experiments, this column displays N/A |
| ![FAM Score Icon](image) | The icon displayed if the well is flagged with Low FAM Score |
| ![VIC Score Icon](image) | The icon displayed if the well is flagged with Low VIC Score |

**Note:** You can sort the table columns by clicking once on the column header. You can change the sorting order with a second click. A third click will clear the sorting order. You can sort the table columns at multiple levels. For example, click the Call column to sort the columns by Call, then hold down the Ctrl key and click the \( C_{RT} \) column to sort by \( C_{RT} \) the wells with the same call.
The Well Table view for the Replicate Group tab of an example study is shown in the following image:

Flag Summary

The Flag Summary screen displays a list of the DigitalSuite™ Software flags; The flag summary table includes the flag description, and the number of wells, targets, sample groups, and replicate groups in which the flag occurs for any experiment added to a study.

The Flag Summary screen for an example study is shown in the following image:
Export the analyzed data

The Export feature of DigitalSuite™ Software enables you to export the analyzed data.

Export procedure

1. Open the study file that contains the data to export, and from the Export Workflow menu, click Export.

2. Select to export all data in one file or in separate files for each data type.
   - **One File** — All data types are exported in one file.
     - If you select the *.csv format, a worksheet is created for each data type.
     - If you select the *.txt format, the data are grouped by data type.
   - **Separate Files** — Each data type is exported in a separate file. For example, if you select all three different data types Amplification, Results - Sample Group, Results - Replicate Group to export, three separate files (one each for Amplification, Results - Sample Group, Results - Replicate Group) are created. You can select the type of file (*.csv or *.txt) to export from the File Type drop-down menu.

3. *(Optional)* Select the Open after export check box to automatically open the file when export is complete.

4. *(Optional)* Select the Export Bookmark Data only check box to only export bookmarked wells, sample groups, or replicate groups.

5. Enter a file name and location.
   a. Enter a name for the export file in the File Name field.
      
      **Note:** If you choose to export data in separate files, each file must have a different name.
   b. Enter the Directory where you want the exported file to save. Click Browse if you do not want to save the export file in the default export folder.
      
      **Note:** To set up the Export File Location, go to Tools > Preferences, and select the User-defined location: check box.

6. Select the data to export. Select the check box of the data to be exported.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification data</td>
<td>Amplification results, such as $C_{RT}$ values and calls</td>
</tr>
<tr>
<td><strong>Note:</strong> Results are reported at a well level</td>
<td></td>
</tr>
<tr>
<td>Results - Sample Group</td>
<td>Results by Sample group</td>
</tr>
<tr>
<td>Results - Replicate Group</td>
<td>Results by Replicate group</td>
</tr>
</tbody>
</table>

   **Note:** Results data are not available for export until the study is analyzed.

   **Note:** To export Multicomponent Data from digital PCR experiments, use the Export feature in the QuantStudio™ 12K Flex Software.

7. Click Start Export.
The Export screen for an example study is shown in the following image:

Note: The screenshot displays the export preview. The export preview lists the first 15 rows of data if there are more than that number. Else, all are displayed.

8. The exported file when opened in Microsoft Excel appears as shown below:
Supporting features

Preferences

Use the Preferences dialog box to set the default location and additional study properties such as display format.

To access the Preferences dialog box, go to \texttt{Tools \rightarrow Preferences}.

\textbf{Note}: You must close all open studies before adjusting the Preferences settings.

In the General tab, change the default location of the *.eds file and display format for date, time, and numeric separator format.

1. Select \texttt{User-defined location}, and browse to the desired location on your computer.
2. To use the default location, select \texttt{Last-accessed location}.

\textbf{IMPORTANT!} If you select the Last-accessed location option and use DigitalSuite™ Software to access an external data storage device, make sure the device is connected to your computer until you close the application.

3. Select the date format from the Date Format drop-down menu.
4. Select the time format from the Time Format drop-down menu.
5. Select the numeric separator format from the Numeric Separator Format drop-down menu.
6. Click \texttt{OK}.

\includegraphics[width=\textwidth]{preferences_dialog.png}

Poisson Calculator

Use the Poisson Calculator dialog box to calculate the copies/µL, lower confidence, and upper confidence for a set of manually entered parameters.

To access the Poisson Calculator dialog box, go to \texttt{Tools \rightarrow Poisson Calculator}.

1. Enter the total number of replicates.
2. Enter the number of negatives.
3. Enter the confidence interval in percent.
4. Enter the well volume in µL.
5. Click **Calculate**.
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

Supporting features
Section 3.2 Analyzing Singleplex Experiments

In this section, you use the example singleplex experiment file provided with the DigitalSuite™ Software to create a study and analyze the digital experiment results. This section includes:

- About Singleplex experiments .......................................................... 65
- Setup a singleplex study ................................................................. 65
  - Create a study ................................................................. 65
  - Define study properties ....................................................... 65
  - Setup plate layout .............................................................. 66
  - Setup samples and targets .................................................... 67
- Analyze the study .......................................................................... 68
- Run QC ......................................................................................... 71
  - Heat Map ................................................................................. 71
  - Amplification Plot ................................................................. 72
  - Flag Summary ......................................................................... 74
- Export the Study ............................................................................ 75

About Singleplex experiments

Singleplex experiments use FAM™ dye as the only reporter dye.

Setup a singleplex study

Setup a study using the singleplex example experiment from the software installation.

Create a study

1. Launch DigitalSuite™ Software, and on the Home screen click Create Study.
2. In the Import dialog box, navigate to C:\Program Files\Applied Biosystems\DigitalSuite Software\examples and select SingleplexExample.eds. Click Import.
   
   Note: This is a single experiment singleplex study. While setting up your own singleplex study, you can add multiple singleplex experiments to a study.

Define study properties

1. Click Properties from the Setup menu to access the Properties screen.
2. Enter the study name ExampleStudy.
3. In the Description field, enter Singleplex example study.
4. In the Comments field, enter any comments, then click Add.
5. Verify that the Study contents and History Summary match those of your singleplex example study.

The Properties screen of the singleplex example study is shown in the following image:

Setup plate layout

1. Click Plate Setup from the Setup menu to access the Plate Setup screen.
2. Click Load Plate Template to load the plate setup contents from the example plate setup file.
3. Browse to C:\Program Files\Applied Biosystems\DigitalSuite Software\examples. Select SingleplexExamplePlateSetup.csv.
   
   Note: For your own singleplex studies, you can setup the plate contents using a previously created plate setup file or click Assign to assign the plate contents. For more information on assigning plate contents, see “Set up plate layout” on page 25.
4. Click Show to show or hide the data elements in the plate.
5. Click Color by: to color the sub-arrays using the different data elements.
6. Click Legend to show or hide the plate layout legend.
The Plate Setup screen of the singleplex example study is shown in the following image:

Setup samples and targets

Use this screen to add samples and target names, and dilutions, in addition to the default ones. The names and dilutions will then appear in the Well Editor in the Plate Setup screen and can be used to set up the plate.

1. Click **Samples/Targets** from the Setup menu to access the Samples/Targets screen.
2. Click **Add** to add sample names. You can also click in the Name column to change the default sample name. Optionally, select a color from the Color drop-down menu.
   **Note:** DigitalSuite™ Software automatically assigns the number of wells for the sample name.
3. Click **Add** to add target names. You can also click in the Name column to change the default target name. Optionally, select a color from the Color drop-down menu.
   **Note:** DigitalSuite™ Software automatically assigns the number of wells for the target name.
4. Click **Add** to add dilutions. You can also click in the Dilution column to change the default dilutions. Optionally, select a color from the Color drop-down menu.
5. Enter the dilution factor for the dilution.
Chapter 3 Analyze Experiment Results using DigitalSuite™ Software

Analyze the study

The Samples/Targets screen of the singleplex example study is shown in the following image:

Analyze the study

Once you have set up the plate, click Analyze. To modify the analysis settings, click Analysis Settings.

The Analysis Settings dialog box for a singleplex example study is shown in the following image:
View digital PCR results

Clicking on the Analysis button automatically takes you to the Digital PCR screen. Alternatively, click Digital PCR from the Results Workflow menu to access the screen. The Confidence Interval value is displayed in the Title Bar of the Digital PCR screen.

Sample Group view

1. Click the Sample Group tab to view the sample group results. For TaqMan® Assay 1, the Copies/µL is 41.2.

2. View the lower confidence (38.9), upper confidence (43.8) values, number of positive (1,184), negative (1,629), and undetermined (3) calls, total number of positive and negative calls (2,813), number of omitted wells (0), and number of empty wells (0).

3. For the Sample Group, NTC the Copies/µL is NA. This is because the number of positive calls for NTC is 0 and the DigitalSuite™ Software cannot calculate the Copies/µL.

4. View the corresponding plot in the lower half of the screen.

5. From the Plot drop-down menu, select Linear Axis (default). The Linear axis plot type displays the Sample Group on the x-axis and Copies/µL on the y-axis.

6. From the View drop-down menu, select Legend.

7. From the Color by: drop-down menu, select Target (default).

The Sample Group view for the singleplex example study is shown in the following image:
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

Analyze the study

Note: For TaqMan® Assay 1, there are 3 undetermined calls. To investigate these 3 calls, go to the Run QC.

Replicate Group view

1. Click the Replicate Group tab to view the sample group results.
   For TaqMan® Assay 1, having dilution 1, the Copies/µL is 41.8. The Copies/µL should be roughly proportional to the dilution series. For example, dilution 0.5 is half of dilution 1 then the Copies/µL for dilution 0.5 should be roughly half of that for dilution 1. In the example study, the Copies/µL for dilution 0.5 is 19.5 which is approximately half of 41.8.
   Note: Life Technologies recommends you to check if the Copies/µL results are always roughly proportional to the dilution series. If the ratio of Copies/µL:dilution is significantly different in the Replicate Groups, check the plate setup or re-run the experiment.

2. For TaqMan® Assay 1, having dilution 1, view the lower confidence (38.1) and upper confidence (45.8) values, number of positive (526), negative (177), and undetermined (1) calls, total number of positive and negative calls (703), number of omitted wells (0), and number of empty wells (0).

3. View the corresponding plot in the lower half of the screen.

4. From the Plot drop-down menu, select Linear Axis (default). The Linear axis plot type displays the Replicate Group on the x-axis and Copies/µL on the y-axis.

5. From the View drop-down menu, select Legend.

6. From the Color by: drop-down menu, select Target (default).

The Replicate Group view for the singleplex example study is shown in the following image:
Run QC

Heat Map

1. Go to Run QC → Heat Map to access the Heat Map screen.
2. In the Experiments view, select SingleplexExample.eds.
3. View the corresponding Heat Map in the lower half of the screen.
   Note: The VIC button appears disabled for singleplex experiments.
4. Roll-over a sub-array. The tool-tip displays the well contents.
5. From the Show drop-down menu, select Flag to display flags in the heat map.
   a. Look out for flagged wells or empty wells.
   b. Check the location of these wells in the plate. If the location does not appear to form any pattern, check the amplification curve in the amplification plot. Based on these assessments, you can decide to manually change the call or omit the well.
   c. Click Analyze to re-analyze the study.
6. From the Color by: drop-down menu, select Call to display the wells by the color of the Call.
7. Click Legend to show or hide the plate legend.

The Heat Map for the singleplex example study is shown in the following image:
Amplification Plot

1. Go to **Run QC  ▶ Amplification Plot** to access the Amplification Plot screen.
2. In the Targets view, select **TaqMan® Assay 1**.
3. View the corresponding Amplification Plot in the lower half of the screen.
4. From the Plot drop-down menu, select **ΔR vs Cycle (Linear)** (default).
5. From the View drop-down menu, select **CRT** to display the CRT icons on the plot.
6. From the Color by: drop-down menu, select **Call** to display the plot by the color of the Call.

The Amplification Plot - Targets tab for the singleplex example study is shown in the following image:

7. In the Sample Group view, select **TaqMan® Assay 1**.
8. View the corresponding Amplification Plot in the lower half of the screen.
9. From the Plot drop-down menu, select **ΔR vs Cycle (Linear)** (default).
10. From the View drop-down menu, select **CRT Range** and **Histogram** to display the CRT range and the Histogram on the plot.
11. From the Color by: drop-down menu, select **Call** to display the plot by the color of the Call.
The Amplification Plot - Sample Group tab for the singleplex example study is shown in the following image:

13. View the corresponding Amplification Plot in the lower half of the screen.
14. From the Plot drop-down menu, select ΔR vs Cycle (Linear) (default).
15. From the View drop-down menu, select C_{RT} to display the C_{RT} icons on the plot.
16. From the Color by: drop-down menu, select Call to display the plot by the color of the Call.
The Amplification Plot - Replicate Group tab for the singleplex example study is shown in the following image:

In the singleplex example study, there are 3 undetermined wells when the study is analyzed with the default analysis settings. You can review the amplification curve for these three wells and after assessing the amplification curves, you can decide whether you want to adjust the $C_{RT}$ range, manually change the call, or omit the well altogether.

Tips for viewing the Amplification Plot for your own study

- Sort the undetermined calls by clicking on the Call column header in the Well Table so that you can select all the undetermined calls quickly and review the respective amplification curves.
- Sort the flagged wells by clicking on the column header or the individual flag column header in the Well Table so that you can select flagged wells quickly and review their amplification curves.
- After assessing the individual amplification curves, you can decide whether you want to adjust the $C_{RT}$ range, manually change the call, or omit the well altogether.
- To view the updated results, you must re-analyze the study after making any of the above changes.

Flag Summary

1. Go to Run QC » Flag Summary to access the Flag Summary screen.
Section 3.2 Analyzing Singleplex Experiments

Export the Study

1. From the Export Workflow menu, click Export.
2. Select One file.
3. Select the Open after export check box.
4. Click Browse to select the directory and location to save the exported file.
5. Enter the file name SingleplexExampleStudy_Export for the exported file.
6. Select .csv from the File Type drop-down menu.
7. Select the Results - Sample Group tab to export the Sample Group results.
8. Click **Start Export**.
The Export screen for the singleplex example study is shown in the following image:

![Export Screen](image)

The exported file when opened in Microsoft Excel is shown in the following image:

![Excel Export](image)
Export the Study
Section 3.3 Analyzing Duplex Experiments

In this section, you use the example duplex experiment file provided with the DigitalSuite™ Software to create a study and analyze the digital experiment results. This section includes:

- About Duplex experiments ................................................................. 79
- Setup a duplex study ................................................................. 79
  - Create a study ................................................................. 79
  - Define study properties ......................................................... 79
  - Setup plate layout ............................................................... 80
  - Setup samples and targets ...................................................... 81
- Analyze the study ................................................................. 82
- Run QC ................................................................. 85
  - Heat Map ................................................................. 85
  - Amplification Plot ............................................................ 86
  - Flag Summary ............................................................... 89
- Export the Study ................................................................. 90

About Duplex experiments

Duplex experiments include two TaqMan® Assays using FAM™ dye and VIC® dye as the reporter dyes respectively.

Setup a duplex study

Setup a study using the duplex example experiment from the software installation.

Create a study

1. Launch DigitalSuite™ Software, and on the Home screen click Create Study.

2. In the Import dialog box, navigate to C:\Program Files\Applied Biosystems\DigitalSuite Software\examples and select DuplexExample.eds. Click Import.

   Note: This contains duplex data from a single OpenArray® plate. When setting up your own Duplex study, you can add duplex data from multiple OpenArray® plates to the study.

Define study properties

1. Click Properties from the Setup menu to access the Properties screen.

2. Enter the study name D ExampleStudy.
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

Setup a duplex study

3. In the Description field, enter **Duplex example study**.
4. In the Comments field, enter any comments, then click **Add**.
5. Verify that the Study contents and History Summary match those of your duplex example study.

The Properties screen of the duplex example study is shown in the following image:

![Properties screen](image)

**Setup plate layout**

1. Click **Plate Setup** from the Setup menu to access the Plate Setup screen.
2. Click **Load Plate Template** to load the plate setup contents from the example plate setup file.
3. Browse to `C:\Program Files\Applied Biosystems\DigitalSuite Software\examples`. Select **DuplexExamplePlateSetup.csv**.
   
   **Note:** For your own duplex studies, you can setup the plate contents using a previously created plate setup file or click **Assign** to assign the plate contents. For more information on assigning plate contents, see “Set up plate layout” on page 25.

4. Click **Show** to show or hide the data elements in the plate.
5. Click **Color by**: to color the sub-arrays using the different data elements.
6. Click **Legend** to show or hide the plate layout legend.
Section 3.3  Analyzing Duplex Experiments

Setup a duplex study

The Plate Setup screen of the duplex example study is shown in the following image:

Setup samples and targets

Use this screen to add samples and target names, and dilutions, in addition to the default ones. The names and dilutions will then appear in the Well Editor in the Plate Setup screen and can be used to set up the plate.

1. Click Samples/Targets from the Setup menu to access the Samples/Targets screen.

2. Click Add to add sample names. You can also click in the Name column to change the default sample name. Optionally, select a color from the Color drop-down menu.

   **Note:** DigitalSuite™ Software automatically assigns the number of wells for the sample name.

3. Click Add to add target names. You can also click in the Name column to change the default target name. Optionally, select a color from the Color drop-down menu.

   **Note:**  DigitalSuite™ Software automatically assigns the number of wells for the target name.

4. Click Add to add dilutions. You can also click in the Dilution column to change the default dilutions. Optionally, select a color from the Color drop-down menu.

5. Enter the dilution factor for the dilution.

In the duplex example study, TaqMan® Assay 1 has FAM™ dye as the reporter dye while TaqMan® Assay 2 has VIC® dye as the reporter dye.
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

Analyze the study

Once you have set up the plate, click **Analyze**. To modify the analysis settings, click **Analysis Settings**.

The Analysis Settings dialog box for a duplex example study is shown in the following image:
Clicking on the Analysis button automatically takes you to the Digital PCR screen. Alternatively, click Digital PCR from the Results Workflow menu to access the screen. The Confidence Interval value is displayed in the Title Bar of the Digital PCR screen.

**Sample Group view**

1. Click the **Sample Group** tab to view the sample group results. For TaqMan® Assay 1, the Copies/µL is 40.5. For TaqMan® Assay 2, the Copies/µL is 28.1.

2. For TaqMan® Assay 1, view the lower confidence (38.1), upper confidence (42.9) values, number of positive (1,168), negative (1,643), and undetermined (3) calls, total number of positive and negative calls (2,811), number of omitted wells (0), and number of empty wells (0).

3. For TaqMan® Assay 1, for the Sample NTC the Copies/µL is NA. This is because the number of positive calls for NTC is 0 and the DigitalSuite™ Software cannot calculate the Copies/µL.

4. For TaqMan® Assay 2, view the lower confidence (26.3), upper confidence (30.0) values, number of positive (905), negative (1,908), and undetermined (1) calls, total number of positive and negative calls (2,813), number of omitted wells (0), and number of empty wells (0).

5. For TaqMan® Assay 2, for the Sample NTC the Copies/µL is NA. This is because the number of positive calls for NTC is 0 and the DigitalSuite™ Software cannot calculate the Copies/µL.

6. View the corresponding plot in the lower half of the screen.

7. From the Plot drop-down menu, select **Linear Axis** (default). The Linear axis plot type displays the Sample Group on the x-axis and Copies/µL on the y-axis.

8. From the View drop-down menu, select **Legend**.

9. From the Color by: drop-down menu, select **Target** (default).
The Sample Group view for the duplex example study is shown in the following image:

![Sample Group view](image)

### Replicate Group view

1. Click the **Replicate Group** tab to view the sample group results.

   For TaqMan® Assay 1, having dilution 1, the Copies/µL is 40.5. The Copies/µL should be roughly proportional to the dilution series. For example, dilution 0.5 is half of dilution 1 then the Copies/µL for dilution 0.5 should be roughly half of that for dilution 1. In the example study, the Copies/µL for dilution 0.5 is 20 which is approximately half of 40.5.

   For TaqMan® Assay 2, having dilution 1, the Copies/µL is 29.7. The Copies/µL should be roughly proportional to the dilution series. For example, dilution 0.5 is half of dilution 1 then the Copies/µL for dilution 0.5 should be roughly half of that for dilution 1. In the example study, the Copies/µL for dilution 0.5 is 13.1 which is approximately half of 29.7.

   **Note:** Life Technologies recommends you to check if the Copies/µL results are always roughly proportional to the dilution series. If the ratio of Copies/µL:dilution is significantly different in the Replicate Groups, check the plate setup or re-run the experiment.

2. For TaqMan® Assay 1, having dilution 1, view the lower confidence (36.6) and upper confidence (44.1) values, number of positive (515), negative (186), and undetermined (2) calls, total number of positive and negative calls (701), number of omitted wells (0), and number of empty wells (1).
3. For TaqMan® Assay 2, having dilution 1, view the lower confidence (26.9) and upper confidence (32.7) values, number of positive (439), negative (264), and undetermined (0) calls, total number of positive and negative calls (703), number of omitted wells (0), and number of empty wells (1).

4. View the corresponding plot in the lower half of the screen.

5. From the Plot drop-down menu, select Linear Axis (default). The Linear axis plot type displays the Replicate Group on the x-axis and Copies/µL on the y-axis.

6. From the View drop-down menu, select Legend.

7. From the Color by: drop-down menu, select Target (default).

The Replicate Group view for the duplex example study is shown in the following image:

---

Run QC

Heat Map

1. Go to Run QC > Heat Map to access the Heat Map screen.
2. In the Experiments view, select DuplexExample.eds.
3. View the corresponding Heat Map in the lower half of the screen.
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

Run QC

**Note:** The VIC button appears enabled for duplex experiments. Click VIC to view the Heat Map for VIC® dye.

4. Roll-over a sub-array. The tool-tip displays the well contents.

5. From the Show drop-down menu, select **Flag** to display flags in the heat map.
   a. Look out for flagged wells or empty wells.
   b. Check the location of these wells in the plate. If the location does not appear to form any pattern, check the amplification curve in the amplification plot. Based on these assessments, you can decide to manually change the call or omit the well.
   c. Click **Analyze** to re-analyze the study.

6. From the Color by: drop-down menu, select **Call** to display the wells by the color of the Call.

7. Click **Legend** to show or hide the plate legend.

The Heat Map for the duplex example study is shown in the following image:

![Image of Heat Map](image_url)

**Amplification Plot**

1. Go to **Run QC** → **Amplification Plot** to access the Amplification Plot screen.

2. In the Targets view, select **TaqMan® Assay 1**.

3. View the corresponding Amplification Plot in the lower half of the screen.
4. From the Plot drop-down menu, select $\Delta R$ vs Cycle (Linear) (default).
5. From the View drop-down menu, select $C_{RT}$ to display the $C_{RT}$ icons on the plot.
6. From the Color by: drop-down menu, select Call to display the plot by the color of the Call.

The Amplification Plot - Targets tab for TaqMan® Assay 1 in the duplex example study is shown in the following image:

7. Perform step 2. through 6. to observe the Amplification Plot for the target TaqMan® Assay 2.
8. In the Sample Group view, select TaqMan® Assay 1.
9. View the corresponding Amplification Plot in the lower half of the screen.
10. From the Plot drop-down menu, select $\Delta R$ vs Cycle (Linear) (default).
11. From the View drop-down menu, select $C_{RT}$ Range and Histogram to display the $C_{RT}$ range and the Histogram on the plot.
12. From the Color by: drop-down menu, select Call to display the plot by the color of the Call.
The Amplification Plot - Sample Group tab for TaqMan® Assay 1 in the duplex example study is shown in the following image:

For TaqMan® Assay 1, DNA Sample 1, there are 3 undetermined wells when the study is analyzed with the default analysis settings. You can review the amplification curve for these three wells and after assessing the amplification curves, you can decide whether you want to adjust the C_{RT} range, manually change the call, or omit the well altogether.

13. Perform step 8. through 12. to observe the Amplification Plot for the target TaqMan® Assay 2.
15. View the corresponding Amplification Plot in the lower half of the screen.
16. From the Plot drop-down menu, select ΔR vs Cycle (Linear) (default).
17. From the View drop-down menu, select C_{RT} to display the C_{RT} icons on the plot.
18. From the Color by: drop-down menu, select Call to display the plot by the color of the Call.
The Amplification Plot - Replicate Group tab for the duplex example study is shown in the following image:

For TaqMan® Assay 1, Dilution 1, there are 2 undetermined wells when the study is analyzed with the default analysis settings. You can review the amplification curve for these three wells and after assessing the amplification curves, you can decide whether you want to adjust the CRT range, manually change the call, or omit the well altogether.

19. Perform step 13. through 18. to observe the Amplification Plot for the target TaqMan® Assay 2 at other dilutions.

Tips for viewing the Amplification Plot for your own study

- Sort the undetermined calls by clicking on the Call column header in the Well Table so that you can select all the undetermined calls quickly and review the respective amplification curves.
- Sort the flagged wells by clicking on the flag column header in the Well Table so that you can select flagged wells quickly and review their amplification curves.
- After assessing the individual amplification curves, you can decide whether you want to adjust the CRT range, manually change the call, or omit the well altogether.
- To view the updated results, you must re-analyze the study after making any of the above changes.

Flag Summary

1. Go to Run QC → Flag Summary to access the Flag Summary screen.
2. View the Flag Summary table.

3. View the number of wells in which the flags Low ROX, Low FAM, Low VIC, Low FAM Score, and Low VIC Score appear.

4. In the duplex example study, the Low ROX and Low FAM flags occur in one well each, while the Low FAM Score flag occurs in three wells. To view the location of the flagged wells, go to Run QC → Heat Map.

   The flagged wells are displayed with a triangle in the well. For the example study, the wells flagged with Low ROX and Low FAM are also empty wells. Therefore the wells also contain a ‘×’ along with the triangle.

The Flag Summary for the duplex example study is shown in the following image:

<table>
<thead>
<tr>
<th>Flag</th>
<th>Icon</th>
<th>Description</th>
<th># of Wells</th>
<th># of Targets</th>
<th># of Sample Groups</th>
<th># of Replicate Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low ROX</td>
<td>✘</td>
<td>The median of ROX signal (first 5 cycles) is lower than the threshold.</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Low FAM</td>
<td>❌</td>
<td>The median of FAM signal (first 5 cycles) is lower than the threshold.</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Low VIC</td>
<td>❌</td>
<td>The median of VIC signal (first 5 cycles) is lower than the threshold.</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Low FAM Score</td>
<td>☑</td>
<td>The FAM score is lower than the threshold.</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Low VIC Score</td>
<td>☑</td>
<td>The VIC score is lower than the threshold.</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Export the Study

1. From the Export Workflow menu, click Export.
2. Select One file.
3. Select the Open after export check box.
4. Click Browse to select the directory and location to save the exported file.
5. Enter the file name DuplexExampleStudy_Export for the exported file.
6. Select .csv from the File Type drop-down menu.
7. Select the Results - Sample Group tab to export the Sample Group results.
8. Click **Start Export**.
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

Export the Study

The Export screen for the duplex example study is shown in the following image:

![Export Screen Image]

The exported file when opened in Microsoft Excel is shown in the following image:

![Exported File Image]
Chapter 3  Analyze Experiment Results using DigitalSuite™ Software

Export the Study
Ordering Information

**Note:** A QuantStudio™ OpenArray® Accessories Kit, Part no. 4469576, is included with 10-pack array orders.

## QuantStudio™ Digital PCR Kits

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
<th>Storage Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuantStudio™ Digital PCR Kit [10 Pack]</td>
<td>4470184</td>
<td>Upon receipt, store the frozen, unopened plates at –20°C.</td>
</tr>
<tr>
<td>QuantStudio™ Digital PCR Kit [4 Pack]</td>
<td>4470185</td>
<td></td>
</tr>
</tbody>
</table>

### Description of components

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuantStudio™ Digital PCR Plates</td>
<td>4470196 (4 Plates)</td>
<td>4 plates or 10 plates, depending on the order</td>
</tr>
<tr>
<td></td>
<td>4470197 (10 Plates)</td>
<td></td>
</tr>
<tr>
<td>2X TaqMan® OpenArray® Digital PCR Master Mix</td>
<td>4458086 (1.5 mL)</td>
<td>1.5 mL or 5 mL, depending on the order</td>
</tr>
<tr>
<td></td>
<td>4458080 (5 mL)</td>
<td></td>
</tr>
<tr>
<td>QuantStudio™ OpenArray® Accessories Kit</td>
<td>4469576</td>
<td>1 kit, enough for 10 arrays (not included with Part no. 4470185)</td>
</tr>
</tbody>
</table>
Documentation and Support

Related documentation

The following related documents are shipped with the system:

<table>
<thead>
<tr>
<th>Document</th>
<th>Part number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System Maintenance and Administration Guide</td>
<td>4470689</td>
<td>Describes the QuantStudio™ 12K Flex System hardware and software and provides information on preparing, maintaining, and troubleshooting the system.</td>
</tr>
<tr>
<td>Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: OpenArray® Experiments User Guide</td>
<td>4470935</td>
<td>Provides brief, step-by-step procedures for performing experiments using the OpenArray® sample block on the QuantStudio™ 12K Flex System. It is designed to help you quickly learn to use the QuantStudio™ 12K Flex System.</td>
</tr>
<tr>
<td>Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide</td>
<td>4470050</td>
<td>Provides brief, step-by-step procedures for performing experiments using the 384-well, 96-well, Fast 96-well plates, and Array Card sample blocks on the QuantStudio™ 12K Flex System. It is designed to help you quickly learn to use the QuantStudio™ 12K Flex System.</td>
</tr>
<tr>
<td>Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System Help</td>
<td>4470695</td>
<td>Describes the QuantStudio™ 12K Flex System software and provides procedures for common tasks.</td>
</tr>
</tbody>
</table>

Portable document format (PDF) versions of the above guides are available at: [www.lifetechnologies.com/quantstudio](http://www.lifetechnologies.com/quantstudio).

**Note:** To open the user documentation, use the Adobe® Reader® software available from [www.adobe.com](http://www.adobe.com).

**Note:** For additional documentation or if you cannot access the user documentation, see “Obtaining support” on page 97.

Obtaining SDSs

Safety Data Sheets (SDSs) are available from [www.lifetechnologies.com/sds](http://www.lifetechnologies.com/sds)

Obtaining support

For service and technical support, call toll-free in US: 1.800.955.6288, or contact your local Life Technologies representative.

For the latest services and support information for all locations, go to: [www.lifetechnologies.com/support](http://www.lifetechnologies.com/support)
At the website, you can:

- Access worldwide telephone and fax numbers to contact Technical Support and Sales facilities
- Search through frequently asked questions (FAQs)
- Submit a question directly to Technical Support
- Search for user documents, SDSs, vector maps and sequences, application notes, formulations, handbooks, certificates of analysis, citations, and other product support documents
- Obtain information about customer training
- Download software updates and patches

**Limited Product Warranty**

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the Life Technologies’ General Terms and Conditions of Sale found on Life Technologies’ website at [www.lifetechnologies.com/termsandconditions](http://www.lifetechnologies.com/termsandconditions). If you have any questions, please contact Life Technologies at [www.lifetechnologies.com/support](http://www.lifetechnologies.com/support).
amplification curve  General term for time series data of PCR fluorescence vs. cycle number; amplification curves are often normalized by a passive reference and usually referred to as Rn vs. Cycle data. Curves that have been baseline compensated (see baselined data) are typically referred to as Rn vs. Cycle data.

amp score  A value that reflects the level of amplification in a well. In general, a low value indicates lesser amplification in that well.

baselined data  Amplification curves where the baseline has been removed by either subtraction or division of a line computed by a linear regression through the baseline region.

blank well  Wells in the sub-array that do not contain any setup information.

certainty interval  The Confidence Interval is used to calculate the lower and upper confidence values in the Digital PCR screen. For example, for a Confidence Interval value of 95%, the actual possibility of copies/µL falling between the lower and upper confidence values is 95%.

\( C_{RT} \)  Result obtained on applying the Relative Threshold algorithm on the amplification curve. The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no dependence on targets, thereby reducing variability.

dilution  The concentration of diluted sample in a well with a value of 0.0 ~ 1.0 normalized against the original concentration of the sample.

empty well  Empty wells are those that are flagged with Low ROX, Low FAM, or Low VIC flags.

flagged well  Wells containing one or more flags.

negative well  Wells with negative calls. Negative calls mean the DigitalSuite™ Software determines that a well does not contain any copy of the sample.

omitted well  Wells manually omitted by a user.

Poisson distribution  In probability theory and statistics, the Poisson distribution (or Poisson law of small numbers) is a discrete probability distribution that expresses the probability of a given number of events occurring in a fixed interval of time and/or space if these events occur with a known average rate and independently of the time since the last event.

positive well  Wells with positive calls. Positive calls mean the DigitalSuite™ Software determines that a well contains at least one copy of the sample.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>replicate group</td>
<td>A group of replicates that share the same sample, target and dilution.</td>
</tr>
<tr>
<td>replicate</td>
<td>A combination of one sample and one target in a well.</td>
</tr>
<tr>
<td>sample group</td>
<td>A group of replicates that share the same sample and target.</td>
</tr>
<tr>
<td>undetermined well</td>
<td>A well is undetermined when a user:</td>
</tr>
<tr>
<td>well</td>
<td>A well in a conventional plate, or a through hole in an OpenArray plate.</td>
</tr>
</tbody>
</table>

- Cannot tell if a well is amplified or not.
- Sees a spurious signal called with a C_T value.
- Does not want to include low efficiency wells in calculations.
Numerics
384-well sample plate 10

A
amplification plot 40
amplification plot, viewing 40
analysis settings 31
digital PCR settings 31
flag settings 31
analysis workflow, general 21
analyzing
duplex experiments 79
singleplex experiments 65
assign 25

B
bookmark 37, 40, 41, 44, 45, 53, 54, 58

C
call
negative 31
positive 31
undetermined 31
color by 26

D
digital PCR
about 9
components 9
digital PCR experiments
about 10
setup 11
workflow 12
digital PCR plate 10
DigitalSuite™ Software
analysis workflow 14
features 13
dilutions, managing 29
documentation, related 97

F
flag settings
low FAM score 31
low VIC score 31
flag summary 59

G
genotyping plate
storage conditions 16

H
heat map 37
experiments 37
heat map for 38
heat map, viewing 37

L
legend 27

M
manage dilutions 29
manage samples 28
manage targets 29

O
Ordering 95
Ordering Information 95

P
perform QC
amplification plot 40
flag summary 59
heat map 37
plate layout
storage conditions 16
plate layout, setting up 25
plate setup
manage experiments 25
plate setup for
(study name) 25
prepare the sample plate
required materials 16

Q
QC, performing 37
QuantStudio OpenArray plate
experiment plate 9
sample plate 9
QuantStudio™ Digital PCR Plate
analyze data 18
Index

prepare 16
procedure 17
run 17
QuantStudio™ OpenArray® plate 9

R
required materials
prepare the sample plate 16
storage conditions 16
results, viewing 32

S
Safety Data Sheets (SDSs), obtaining 97
sample plate
prepare 15
required materials 16
samples and targets, setting up 28
samples, managing 28
setting up samples and targets
manage dilutions 29
manage samples 28
manage targets 29
show 26
storage conditions 16
study properties, defining 23
study, analyzing 31
study, creating 22
support, obtaining 97

T
targets, managing 29
training, information on 98

V
view results
replicate group tab 34
sample group tab 32